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Introduction 

 

Welcome to Teknimedia’s PCIC
3
B2 GS3–Key Applications-Excel (PCIC

2
B2 GS3) Study 

Guide! This guide has been developed to help you complete PCIC
3
B and prepare for the Internet 

and Computing Core Certification (IC
3
) Key Applications exam. 

 

Following is an overview of the materials included in this guide: 

 

1.  Learning Objectives 

 
This section of the guide provides you with a list of learning objectives covered by PCIC

2
B2 

GS3. 

 

2.  Course Table of Contents 

 

This section provides you with a list of all the lessons, interactive exercises and quizzes 

provided in PCIC
2
B2 GS3. 

 

3.  Curriculum Mapping 

This section maps the sections of PCIC
3
B2 GS3 to IC

3
 GS3-Key Applications as well as the 

exam objectives of IC
3
 GS3-Key Applications to the sections of PCIC

3
B2 GS3. 

 

4.  Lessons and Reading Supplements 

 

This section provides you with the full text of all course lessons -- plus the text of the sections 

used to introduce and conclude the course. Lessons and Reading Supplements also provides 

you with the full text of all reading supplements included in the course. 
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PCIC
3
B2 GS3 - Learning Objectives 

 

PCIC
3
B2 GS3 covers the knowledge and skills pertaining to the objectives for the spreadsheet 

component of the IC3 Key Applications.   
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PCIC
3
B2 GS3 - Table of Contents 

 

B  Introduction 

B1 Unit 1 

B1.1 Spreadsheets Overview 

B1.2 Getting Started 

B1.3  Ribbon 

B1.4  Entering Data 

B1.5 Ex-Entering Data 

B1.6 Editing Data 

B1.7 Ex-Editing Data 

B1.8 Formulas 

B1.9 Ex-Formulas 

B1.10 Functions 

B1.11 Ex-Functions 

B1.12 Saving Workbooks 

B1.13 Ex-Saving Workbooks-1 

B1.14 Ex-Saving Workbooks-2 

B1.15 Creating a New Workbook 

B1.16 Ex-Creating a New Workbook 

B1.17 Opening Workbooks 

B1.18 Ex-Opening Workbooks 

B1.19 Quiz 1-1 

B1.20  Fonts 

B1.21 Ex-Fonts 

B1.22 Alignment 

B1.23  Ex-Alignment 

B1.24  Number Formats 

B1.25 Ex-Number Formats 

B1.26 Format Painter 

B1.27 Ex-Format Painter 

B1.28 Resizing Rows & Columns 

B1.29 Ex-Resizing Rows & Columns 

B1.30 Printing 

B1.31 Ex-Printing-1 

B1.32 Ex-Printing-2 

B1.33 Office Clipboard 

B1.34 Ex-Office Clipboard 

B1.35 Getting Help 

B1.36 Ex-Getting Help 

B1.37 Quiz 1-2 

B1.38 Unit 1 End 

B2 Unit 2 

B2.1 Filling Cells 

B2.2 Ex-Filling Cells 
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B2.3 Editing Data Efficiently 

B2.4 Ex-Editing Data Efficiently 

B2.5 Inserting & Deleting Cells 

B2.6 Ex-Inserting & Deleting Cells 

B2.7 Inserting & Deleting Rows & Columns 

B2.8 Ex-Inserting & Deleting Rows & Columns 

B2.9 Data Fitting Errors 

B2.10 Spelling Check 

B2.11 Ex-Spelling Check 

B2.12 Find & Replace 

B2.13 Ex-Find & Replace 

B2.14 Quiz 2-1 

B2.15 Formulas Containing Multiple Operators 

B2.16 Ex-Formulas Containing Multiple Operators 

B2.17 Commonly Used Functions 

B2.18 Ex-Commonly Used Functions 

B2.19 Inserting Functions in Formulas 

B2.20 Ex-Inserting Functions in Formulas 

B2.21 Modifying Formulas & Functions 

B2.22 Ex-Modifying Formulas & Functions 

B2.23 Copying Formulas & Functions 

B2.24 Ex-Copying Formulas & Functions 

B2.25 Formula & Function Errors 

B2.26 Ex-Formula & Function Errors 

B2.27 Organizing Worksheets 

B2.28 Ex-Organizing Worksheets 

B2.29 Templates 

B2.30 Ex-Templates 

B2.31 Time Saving Tips 

B2.32 Ex-Time Saving Tips 

B2.33 RS-Save Formats 

B2.34 Ex-Save Formats 

B2.35 Quiz 2-2 

B2.36 Unit 2 End 

B3 Unit 3 

B3.1 Wrapping Text in a Cell 

B3.2 Ex-Wrapping Text in a Cell 

B3.3 Changing the Orientation of Data 

B3.4 Ex-Changing the Orientation of Data 

B3.5 Cell Borders 

B3.6 Ex-Cell Borders 

B3.7 Cell Shading 

B3.8 Ex-Cell Shading 

B3.9 Styles 

B3.10 Ex-Styles 
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B3.11  Inserting Clip Art 

B3.12 Ex-Inserting Clip Art 

B3.13 Ex-Resizing Clip Art 

B3.14  Adding Drawings 

B3.15 Ex-Adding Drawings 

B3.16 Modifying Drawings 

B3.17 Ex-Modifying Drawings 

B3.18 Quiz 3-1 

B3.19 Page Breaks 

B3.20 Ex-Page Breaks 

B3.21 Header & Footer 

B3.22 Ex-Header & Footer 

B3.23 Hiding Rows & Columns 

B3.24 Ex-Hiding Rows & Columns 

B3.25 Sorting Data 

B3.26 Ex-Sorting Data 

B3.27 Filtering Data 

B3.28 Ex-Filtering Data 

B3.29 Print Area 

B3.30  Ex-Print Area 

B3.31 Print Scaling 

B3.32 Ex-Print Scaling 

B3.33  Printing Titles and Gridlines 

B3.34 Ex-Printing Titles and Gridlines 

B3.35 Creating Charts 

B3.36  Ex-Creating Charts 

B3.37 Modifying Charts-1 

B3.38  Ex-Modifying Charts-1 

B3.39  Modifying Charts-2 

B3.40  Ex-Modifying Charts-2 

B3.41  Interpreting Data and Charts 

B3.42 RS-Guidelines for Creating Spreadsheets 

B3.43  Quiz 3-2 

B3.44  Unit 3 End 



 

Teknimedia Corporation 7 PCIC
3
B2 GS3 

 
 

Curriculum Mapping:  PCIC
3
B2 GS3 to IC

3
B GS3 

 

 
PCIC3B2 GS3 

Section # 
Section Name 

IC³B GS3 
Reference # 

B Introduction none 

B1 Unit 1 none 

B1.1 Spreadsheets Overview none 

B1.2 Getting Started IC³-2    1.1.1 
  IC³-2    1.2.1 
  IC³-2    3.1.4 

B1.3 Ribbon IC³-2    1.1.2 

B1.4 Entering Data IC³-2    1.3.2 
  IC³-2    3.1.1 
  IC³-2    3.1.3 

B1.5 Ex-Entering Data IC³-2    1.3.2 
  IC³-2    3.1.3 

B1.6 Editing Data IC³-2    3.1.2 
  IC³-2    1.3.3 
  IC³-2    3.1.3 

B1.7 Ex-Editing Data IC³-2    3.1.2 
  IC³-2    1.3.3 
  IC³-2    3.1.3 

B1.8 Formulas IC³-2    3.2.7 

B1.9 Ex-Formulas IC³-2    3.2.7 

B1.10 Functions IC³-2    3.2.5 
  IC³-2    3.2.6 
  IC³-2    3.2.7 

B1.11 Ex-Functions IC³-2    3.2.5 
  IC³-2    3.2.6 
  IC³-2    3.2.7 

B1.12 Saving Workbooks IC³-2    1.2.2 
  IC³-2    1.2.4 
  IC³-2    1.2.5 

B1.13 Ex-Saving Workbooks-1 IC³-2    1.2.4 
  IC³-2    1.2.5 

B1.14 Ex-Saving Workbooks-2 IC³-2    1.2.4 
IC³-2    1.2.5 

B1.15 Creating a New Workbook IC³-2    1.2.1 
  IC³-2    1.2.5 

B1.16 Ex-Creating a New Workbook IC³-2    1.2.1 
  IC³-2    1.2.5 

B1.17 Opening Workbooks IC³-2    1.1.1 
  IC³-2    1.2.2 

B1.18 Ex-Opening Workbooks IC³-2    1.2.2 

B1.19 Quiz 1-1  

B1.20 Fonts IC³-2    1.3.2 
  IC³-2    1.3.6 

B1.21 Ex-Fonts IC³-2    1.3.2 
  IC³-2    1.3.6 
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PCIC3B2 GS3 

Section # 
Section Name 

IC³B GS3 
Reference # 

B1.22 Alignment IC³-2    1.3.6 
  IC³-2    3.1.7 

B1.23 Ex-Alignment IC³-2    1.3.6 
  IC³-2    3.1.7 

B1.24 Number Formats IC³-2    3.1.5 

B1.25 Ex-Number Formats IC³-2    3.1.5 

B1.26 Format Painter IC³-2    1.3.6 

B1.27 Ex-Format Painter IC³-2    1.3.6 

B1.28 Resizing Rows and Columns IC³-2    3.1.4 

B1.29 Ex-Resizing Rows and Columns IC³-2    3.1.4 

B1.30 Printing IC³-2    1.1.8 
  IC³-2    1.4.2 
  IC³-2    1.4.3 

B1.31 Ex-Printing-1 IC³-2    1.4.2 

B1.32 Ex-Printing-2 IC³-2    1.4.3 

B1.33 Office Clipboard IC³-2    1.3.2 

B1.34 Ex-Office Clipboard IC³-2    1.3.2 

B1.35 Getting Help IC³-2    1.1.8 
  IC³-2    1.1.9 

B1.36 Ex-Getting Help IC³-2    1.1.9 

B1.37 Quiz 1-2  

B1.38 Unit 1-End  

B2 Unit 2-Intermediate Spreadsheets 1  

B2.1 Filling Cells IC³-2    3.1.3 

B2.2 Ex-Filling Cells IC³-2    3.1.3 

B2.3 Moving & Copying Data Efficiently IC³-2    1.3.2 

B2.4 Ex-Moving & Copying Data Efficiently IC³-2    1.3.2 

B2.5 Inserting and Deleting Cells IC³-2    3.1.4 

B2.6 Ex-Inserting and Deleting Cells IC³-2    3.1.4 

B2.7 Inserting and Deleting Rows and 
Columns 

IC³-2    3.1.4 

B2.8 Ex-Inserting and Deleting Rows and 
Columns 

IC³-2    3.1.4 

B2.9 Data Fitting Errors none 

B2.10 Spelling Check IC³-2    1.3.5 

B2.11 Ex-Spelling Check IC³-2    1.3.5 

B2.12 Find and Replace IC³-2    1.3.4 

B2.13 Ex-Find and Replace IC³-2    1.3.4 

B2.14 Quiz 2-1  

B2.15 Formulas Containing Multiple Operators IC³-2    3.2.4 
  IC³-2    3.2.8 

B2.16 Ex-Formulas Containing Multiple 
Operators 

IC³-2    3.2.4 

B2.17 Commonly Used Functions IC³-2    3.2.5 

B2.18 Ex-Commonly Used Functions IC³-2    3.2.5 

B2.19 Inserting Functions in Formulas IC³-2    3.2.4 

B2.20 Ex-Inserting Functions in Formulas IC³-2    3.2.4 

B2.21 Modifying Formulas and Functions IC³-2    3.2.7 

B2.22 Ex-Modifying Formulas and Functions IC³-2    3.2.7 
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PCIC3B2 GS3 
Section # 

Section Name 
IC³B GS3 

Reference # 

B2.23 Copying Formulas and Functions IC³-2    3.2.3 
  IC³-2    3.2.4 

B2.24 Ex-Copying Formulas and Functions IC³-2    3.2.3 
  IC³-2    3.2.4 

B2.25 Formula and Function Errors IC³-2    3.2.8 

B2.26 Ex-Formula and Function Errors IC³-2    3.2.8 

B2.27 Organizing Worksheets IC³-2    3.1.4 

B2.28 Ex-Organizing Worksheets IC³-2    3.1.4 

B2.29 Templates IC³-2    1.2.1 
  IC³-2    1.2.4 

B2.30 Ex-Templates IC³-2    1.2.1 
  IC³-2    1.2.4 

B2.31 Time Saving Tips none 

B2.32 Ex-Time Saving Tips none 

B2.33 RS-Save Formats IC³-2    1.2.4 

B2.34 Ex-Save Formats IC³-2    1.2.4 

B2.35 Quiz 2-2  

B2.36 Unit 2-End none 

B3 Unit 3 none 

B3.1 Wrapping Text in a Cell IC³-2    3.1.4 

B3.2 Ex-Wrapping Text in a Cell IC³-2    3.1.4 

B3.3 Changing the Orientation of Data  none 

B3.4 Ex- Changing the Orientation of Data none 

B3.5 Cell Borders IC³-2    3.1.6 

B3.6 Ex-Cell Borders IC³-2    3.1.6 

B3.7 Cell Shading IC³-2    3.1.6 

B3.8 Ex-Cell Shading IC³-2    3.1.6 

B3.9 Styles IC³-2    3.1.8 

B3.10 Ex-Styles IC³-2    3.1.8 

B3.11 Inserting Clip Art IC³-2    1.3.7 

B3.12 Ex-Inserting Clip Art IC³-2    1.3.7 

B3.13 Ex-Resizing Clip Art IC³-2    1.3.7 

B3.14 Adding Drawings IC³-2    1.3.7 

B3.15 Ex-Adding Drawings IC³-2    1.3.7 

B3.16 Modifying Drawings IC³-2    1.3.7 

B3.17 Ex-Modifying Drawings IC³-2    1.3.7 

B3.18 Quiz 3-1  

B3.19 Page Breaks IC³-2    3.1.9 

B3.20 Ex-Page Breaks IC³-2    3.1.9 

B3.21 Header and Footer IC³-2    3.1.9 

B3.22 Ex-Header and Footer IC³-2    3.1.9 

B3.23 Hiding Rows and Columns none 

B3.24 Ex-Hiding Rows and Columns none 

B3.25 Sorting Data IC³-2    3.2.1 

B3.26 Ex-Sorting Data IC³-2    3.2.1 

B3.27 Filtering Data IC³-2    3.2.2 

B3.28 Ex-Filtering Data IC³-2    3.2.2 
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PCIC3B2 GS3 

Section # 
Section Name 

IC³B GS3 
Reference # 

B3.29 Print Area IC³-2    3.2.9 

B3.30 Ex-Print Area IC³-2    3.2.9 

B3.31 Print Scaling IC³-2    3.2.9 

B3.32 Ex-Print Scaling IC³-2    3.2.9 

B3.33 Printing Titles and Gridlines IC³-2    3.2.9 

B3.34 Ex-Print Titles and Gridlines IC³-2    3.2.9 

B3.35 Creating Charts IC³-2    3.2.9 

B3.36 Ex-Creating Charts IC³-2    3.2.9 

B3.37 Modifying Charts-1 IC³-2    3.2.9 

B3.38 Ex-Modifying Charts-1 IC³-2    3.2.9 

B3.39 Modifying Charts-2 IC³-2    3.2.9 

B3.40 Ex-Modifying Charts-2 IC³-2    3.2.9 

B3.41 Interpreting Data and Charts IC³-2    3.2.10 

B3.42 RS-Guidelines for Creating Spreadsheets IC³-2    3.1.2 

B3.43 Quiz 3-2  

B3.44 Unit 3 End none 

 



 

Teknimedia Corporation 11 PCIC
3
B2 GS3 

 
 

Curriculum Mapping:  IC
3 
GS3 to PCIC

3
B2 GS3 

 
IC³B GS3 

Reference # 
PCIC³B2 GS3 

Section # 
Section Name 

IC³-2    1.1.1 B1.2 
B1.17 

Getting Started 
Opening Workbooks 

IC³-2    1.1.2 B1.2 
B1.3 
B1.4 

Getting Started 
Ribbon 
Entering Data 

IC³-2    1.1.3  Covered in PCIC3B1 GS3 and PCIC3B3 
GS3 

IC³-2    1.1.4 B1.3 Ribbon 

IC³-2    1.1.5  Covered in PCIC3B1 GS3 and PCIC3B3 
GS3 

IC³-2    1.1.6  Covered in PCIC3B3 GS3 

IC³-2    1.1.7  Covered in PCIC3B1 GS3 

IC³-2    1.1.8 B1.35 
B1.30 

Getting Help 
Printing 

IC³-2    1.1.9 B1.35 Getting Help 

IC³-2    1.2.1 B1.15 
B1.16 
B2.29 
B2.30 

Creating a New Workbook 
Ex-Creating a New Workbook 
Templates 
Ex-Templates 

IC³-2    1.2.2 B1.17 
B1.18 
B1.12 
B1.13 
B1.14 

Opening Workbooks 
Ex-Opening Workbooks 
Saving Workbooks 
Ex-Saving Workbooks-1 
Ex-Saving Workbooks-2 

IC³-2    1.2.3  Covered in PCIC3B1 GS3 

IC³-2    1.2.4 B1.12 
B1.13 
B1.14 

Saving Workbooks 
Ex-Saving Workbooks-1 
Ex-Saving Workbooks-2 

IC³-2    1.2.5 B1.12 
B1.13 
B1.14 
B1.15 
B2.16 

Saving Workbooks 
Ex-Saving Workbooks-1 
Ex-Saving Workbooks-2 
Creating a New Workbook 
Ex-Creating a New Workbook 

IC³-2    1.2.6 B1.15 Covered in PCIC3B1 GS3 

IC³-2    1.3.1 B1.4 
B1.5 

Entering Data  
Ex-Entering Data 

IC³-2    1.3.2 B1.4 
B1.5 
B1.6 
B1.7 
B1.20 
B1.21 
B2.3 
B2.4 
B1.33 
B1.34 

Entering Data  
Ex-Entering Data 
Editing Data 
Ex-Editing Data 
Fonts 
Ex-Fonts 
Moving & Copying Data Efficiently 
Ex- Moving & Copying Data Efficiently 
Office Clipboard 
Ex-Clipboard 
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IC³B GS3 

Reference # 
PCIC³B2 GS3 

Section # 
Section Name 

IC³-2    1.3.3  Covered in PCIC3B1 GS3 

IC³-2    1.3.4 B2.12 
B2.13 

Find & Replace 
Ex-Find & Replace 

IC³-2    1.3.5 B2.10 Spelling Check 
 B2.11 Ex-Spelling Check 

IC³-2    1.3.6 B1.20 Fonts 
 B1.21 

B1.22 
B1.23 

Ex-Fonts 
Alignment 
Ex-Alignment 

IC³-2    1.3.7 B3.11 Inserting ClipArt 
 B3.12 

B3.13 
B3.14 
B3.15 
B3.16 
B3.17 

Ex-Inserting ClipArt 
Ex-Resizing ClipArt 
Adding Drawings 
Ex-Adding Drawings 
Modifying Drawings 
Ex-Modifying Drawings 

IC³-2    1.4.1 B1.33 Covered in PCIC3B1 GS3 

IC³-2    1.4.2 B1.30 Printing 
 B1.31 Ex-Printing-1 

IC³-2    1.4.3 B1.30 Printing 
 B1.32 Ex-Printing-2 

IC³-2    1.4.4  Covered in PCIC3B1 GS3 

IC³-2    1.4.5  Covered in PCIC3B1 GS3 

IC³-2    1.4.6  Covered in PCIC3B1 GS3 

IC³-2    1.4.7  Covered in PCIC3B1 GS3 

IC³-2    3.1.1 B1.4 
B1.8 
B1.10 

Entering Data 
Formulas 
Functions 

IC³-2    3.1.2 B3.42 RS-Guidelines for Creating 
Spreadsheets 

IC³-2    3.1.3 B1.4 Entering Data 
 B1.5 Ex-Entering Data 
 B1.6 Editing Data 
 B1.7 Ex-Editing Data 
 B2.1 Filling Cells 
 B2.2 Ex-Filling Cells 

IC³-2    3.1.4 B2.5 Inserting & Deleting Cells 
 B2.6 Ex-Inserting & Deleting Cells 
 B2.7 Inserting & Deleting Rows & Columns 
 B2.8 Ex-Inserting & Deleting Rows & 

Columns 
 B2.27 Organizing Worksheets 
 B2.28 

B1.28 
B1.29 
B3.1 
B3.2 

Ex-Organizing Worksheets 
Resizing Rows & Columns 
Ex-Resizing Rows & Columns 
Wrapping Text in a Cell 
Ex-Wrapping Text in a Cell 
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IC³B GS3 

Reference # 
PCIC³B2 GS3 

Section # 
Section Name 

IC³-2    3.1.5 B1.24 Number Formats 
 B1.25 Ex-Number Formats 

IC³-2    3.1.6 B3.5 Cell Borders 
 B3.6 Ex-Cell Borders 
 B3.7 Cell Shading 
 B3.8 Ex-Cell Shading 

IC³-2    3.1.7 B1.22 Alignment 
 B1.23 Ex-Alignment 

IC³-2    3.1.8 B3.9 
B3.10 

Styles 
Ex-Styles 

IC³-2    3.1.9 B3.19 
B3.20 
B3.29 
B3.30 
B3.31 
B3.32 
B3.33 
B3.34 
B3.21 
B3.22 

Page Breaks 
Ex-Page Breaks 
Print Area 
Ex-Print Area 
Print Scaling 
Ex-Print Scaling 
Printing Titles & Gridlines 
Ex-Printing Titles & Gridlines 
Header & Footer 
Ex-Header & Footer 

IC³-2    3.1.10 B3.42 RS-Guidelines for Creating 
Spreadsheets 

IC³-2    3.2.1 B3.25 Sorting Data 
 B3.26 Ex-Sorting Data 

IC³-2    3.2.2 B3.27 
B3.28 

Filtering Data 
Ex-Filtering Data 

IC³-2    3.2.3 B2.23 Copying Formulas & Functions 
 B2.24 Ex-Copying Formulas & Functions 

IC³-2    3.2.4 B2.15 Formulas Containing Multiple Operators 
 B2.16 Ex-Formulas Containing Multiple 

Operators 
 B2.19 Inserting Functions in Formulas 
 B2.20 

B2.23 
B2.24 

Ex-Inserting Functions in Formulas 
Copying Formulas & Functions 
Ex-Copying Formulas &Functions 

IC³-2    3.2.5 B1.10 Functions 
 B1.11 Ex-Functions 
 B2.17 Commonly Used Functions 
 B2.18 Ex-Commonly Used Functions 

IC³-2    3.2.6 B1.10 Functions 
 B1.11 Ex-Functions 

IC³-2    3.2.7 B1.8 
B1.9 
B1.10 
B1.11 

Formulas  
Ex-Formulas 
Functions 
Ex-Functions 
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IC³B GS3 

Reference # 
PCIC³B2 GS3 

Section # 
Section Name 

IC³-2    3.2.8 B2.25 Formula and Function Errors 
 B2.26 

B2.15 
B2.16 

Ex-Formula and Function Errors 
Formulas Containing Multiple Operators 
Ex-Formulas Containing Multiple 
Operators 

IC³-2    3.2.9 B3.35 Creating Charts 
 B3.36 Ex-Creating Charts 
 B3.37 Modifying Charts-1 
 B3.38 Ex-Modifying Charts-1 
 B3.39 Modifying Charts-2 
 B3.40 Ex-Modifying Charts-2 

IC³-2    3.2.10 B3.41 Interpreting Data & Charts 



 

 

NOTES: 
 

 

 

 

 
Teknimedia Corporation 15 PCIC

3
B2 GS3 

 
 

PCIC
3
B2 GS3 - Lessons 

 

Unit 1 
 

 
B Introduction 

 

The course you're about to take will teach you spreadsheet skills using Microsoft Excel 2007 to 

help you prepare for the IC3-GS3 Key Applications certification exam. 

 

The course is designed for Intermediate level computer users. Its prerequisite is "PCIC3A-

Computing Fundamentals," or equivalent knowledge and skills. 

 

Excel 2007 can be used on Windows 7, Windows Vista and Windows XP. This course is based 

on Excel 2007 running on Windows Vista. However, the skills that you learn in the course will 

also be applicable to Excel 2007 running on Windows 7 and Windows XP. 

 

B1 Unit 1 

 

In this course you'll learn how to: 

 

 use the Excel 2007 Ribbon 

 enter data 

 edit data 

 enter formulas 

 insert functions 

 save workbooks 

 create new workbooks 

 open workbooks 

 apply fonts 

 align data 

 set number formats 

 use the Format Painter 

 resize rows and columns 

 print workbooks 

 use the clipboard 

 and get help 



 

 

NOTES: 
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B1.1 Spreadsheets Overview 

 

The Spreadsheets program is a powerful and flexible application that lets you work with data in 

many useful ways. You can use spreadsheets to: 

 

 organize a set of data 

 perform calculations on the data 

 and format the data to make it look more attractive and easier to read 

 

One of the most important features of the Spreadsheets program is that it keeps the relationship 

of its data elements. For example, this number is a part of these calculations. As a result, if you 

change the number, the result of the calculations will be automatically updated. 

 

The capabilities of the Spreadsheets program make it very suitable for a variety of business and 

personal applications such as creating budgets, tracking stock transactions, and generating sales 

reports. 

 

This course will teach you how to work with spreadsheets, using Microsoft Excel 2007, the 

world’s most popular spreadsheet program.  

 

B1.2 Getting Started 

 

In this course, I’ll teach you the basics of spreadsheets, using Microsoft Excel 2007. The 

concepts and skills that you’ll learn in the course will also apply to the previous versions of 

Excel, including Excel 2003, 2002, and 2000. 

 

You can start Excel from the Start button’s "All Programs" menu. Excel 2007 is usually located 

in the Microsoft Office folder, so open the folder, and select Microsoft Office Excel 2007. 

Excel’s window will appear. 

 

The window contains an area made up of cells where you can enter data. This area is referred to 

as a Spreadsheet, or a Worksheet. Excel contains multiple worksheets, collectively referred to, as 

a Workbook. 
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The Excel window also contains the following elements: 

 

 The "Office" button contains functions for managing spreadsheets. 

 The "Quick Access Toolbar" provides quick access to frequently used functions. 

 The Title bar displays the workbook's name. 

 The Minimize button hides the window without closing it. 

 The Maximize button expands the window to its maximum size. 

 The Close button closes the window and the workbook in it. 

 The "Ribbon" organizes all Excel functions in a way that makes them easy to find and 

use. 

 the "Formula Bar" displays the name and contents of the cells in the worksheet; 

 the "Scroll Bars" let you move around in a worksheet 

  the "Status Bar" displays information about the functions you perform 

 "View" buttons let you change the way the spreadsheet is displayed on the screen. 

 and the "Zoom" controls let you specify how large the spreadsheet appears on the screen. 

 

B1.3 Ribbon 

 

The Excel 2007 window includes a "Ribbon" that organizes all Excel functions in a way that 

makes them easy to find and use. The "Ribbon" replaces the menus and toolbars in previous 

versions of Excel. 

 

The "Ribbon" contains tabs across its top corresponding to different categories of functions. The 

default tab is "Home." The "Home" tab contains the most commonly used functions for editing 

and formatting the data in a worksheet. 

 

The functions in a tab are divided into groups. Each group contains functions related to a 

particular set of tasks. For example, the "Clipboard" group contains functions for copying data, 

the "Font" group contains functions for changing the appearance of data, and the "Alignment" 

group contains functions for changing the alignment, position and direction of the data in a cell. 

 

Some groups contain a small icon on their lower right, referred to as the "Dialog Box Launcher." 

Clicking on a dialog box launcher will open a dialog box containing more functions related to its 

group.  

 

You can display the functions in another tab, for example this one, by simply clicking on it. The 

tab’s functions will be displayed. 
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Depending on the size of the Excel window, a tab might not have enough space to display all the 

functions in its groups. In such a case, some groups will appear as a single button. If you click on 

a group’s button, for example this one, its functions will be displayed. 

 

You can easily hide the Ribbon’s functions to make the worksheet area larger. Simply double 

click on the active tab. The function groups will disappear, and the worksheet area will become 

larger. To display the Ribbon’s functions again, simply double click on the desired tab, for 

example this one. The tab’s functions will be displayed. 

 

You’ll be using the Ribbon frequently when working on a spreadsheet. I’ll explain how to use 

various Ribbon functions where applicable throughout the course. 

 

B1.4 Entering Data 

 

In this lesson, I’ll teach you how to enter data into a worksheet. 

 

A worksheet is made up of rows, marked by numbers, and columns marked by letters. The area 

where a row and column cross is referred to as a cell. Each cell is identified by a "cell reference," 

consisting of the cell’s column letter, followed by its row number. For example, this cell’s 

reference is F7, and this cell’s reference is D8. 

 

The worksheet contains, an active cell, which is marked by a thick border. You can enter data 

only in the active cell. You can activate any cell in the worksheet, for example this one, by 

simply clicking on it. When you place the mouse pointer over a cell, the pointer changes to a 

cross. You can then click on the cell to activate it. The active cell’s reference is shown in the text 

box on the left of the Formula bar. Only one of the cells in the worksheet can be active at any 

time. 

 

Now, let’s enter some data in this worksheet. First, let’s reactivate cell A1, and type in a title for 

the worksheet in that cell, for example this title. The data that you type in a cell will also appear 

in the formula bar. Once you’ve typed in the desired data, press the Enter key. The data will be 

entered in the cell, and the next cell in the same column will be automatically activated.   

 

Let’s type in another title in this cell, for example this title. If the text is too long to fit in the cell, 

simply continue typing. The text will automatically spill into the next cell. Again, once you’ve 

entered the desired data, press the Enter key.  
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The text that spills into another cell only belongs to the cell where it was originally entered. As a 

result, if you activate the cell that the text spilled into, nothing will be displayed in the Formula 

Bar. However, if you select the original cell, the whole text will appear in the Formula Bar.  

 

Now let’s activate this cell, and enter a heading in it, for example this one. Then enter the 

appropriate data under the heading. 

 

If you type in an incorrect character, for example this one, simply press the Backspace key to 

delete the last character you typed. Then, enter the correct character and continue typing. 

 

Now let’s enter another heading, in this cell, and then enter some numbers under it. 

 

The numbers that you enter are automatically aligned to the right. 

 

Now let’s quickly enter the rest of this spreadsheet’s data. 

 

B1.6 Editing Data  

 

In this lesson, I’ll teach you various ways to edit the data that has been entered into a worksheet. 

I’ll show you how to: 

 

 modify 

 delete 

 move 

 and copy data 

 

Modifying Data 

You can easily modify the data in any of the worksheet’s cells. For example, let’s change the text 

in this cell. To modify a cell’s data, first select the cell. The cell’s contents will appear in the 

Formula bar. You can then make the desired changes to the data in the Formula bar. For 

example, you can add a word at the beginning of this text, by first placing the insertion point at 

the appropriate position, and then typing the desired word. After you’re done, press the Enter 

key. The change you made will be entered in the cell. 

 

Now, let’s modify the number in this cell. Again, first select the cell. Then change its contents in 

the Formula bar. The Formula bar contains an "Enter" button that works like the Enter key. You 

can click on this button instead of pressing the Enter key to enter your change. The new data will 

be entered in the cell. 



 

 

NOTES: 
 

 

 

 

 
Teknimedia Corporation 20 PCIC

3
B2 GS3 

 
 

 

Now let’s modify the contents of another cell, for example this one. Sometimes after you’ve 

modified a cell’s data, you may not like the changes you made and would like to restore the 

original data. The Formula bar contains a "Cancel" button that lets you cancel the changes you 

made. Simply click on this button. Your change will be cancelled and the cell’s original data will 

be restored.   

 

Now, let’s modify this cell’s contents. You can also enter your change directly in the cell itself, 

without using the Formula bar. Simply double-click on the cell. The insertion point will appear 

in the cell indicating that it can be edited. You can then modify the cell’s contents as desired. 

Once you’ve made your change, click on the "Enter" button. The change you made will be 

entered in the cell. 

 

Deleting Data 

You can easily delete the data in any of the worksheet’s cells. For example, let’s delete this cell’s 

data. To delete a cell’s data, first select the cell, and then simply press the Delete key. The cell’s 

contents will be deleted. 

 

Moving Data 

You can easily move data from one cell to another. For example, let’s move this cell’s data, to 

this cell. To move a cell’s data, first select the cell. Then click on the "Cut" button in the 

"Clipboard" group, of the "Home" tab. A dashed line will appear around the cell, indicating its 

data is ready to be moved. Now, select the cell where you want to move the data, and then click 

on the "Paste" button in the "Clipboard" group.  The data will be moved to that cell. 

 

Copying Data 

You can easily copy a cell’s data into another cell. For example, let’s copy this cell’s data, into 

this cell. Again, first select the cell containing the desired data. Then, click on the "Copy" button 

in the "Clipboard" group.  Now, select the cell where you want to copy the data, and click on the 

"Paste" button. The data will be copied into the specified cell. 

 

When you copy data into a cell, the "Paste Options" button will appear on the cell’s lower right. 

This button lets you change the data’s appearance. Simply ignore the button to leave the data’s 

appearance unchanged. Once you’ve copied the data, press the Enter key. The data will be 

entered in the cell. 
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B1.8 Formulas 

 

Excel provides a powerful feature, referred to as Formula that lets you perform calculations on 

the worksheet’s data. 

 

Let’s use formulas to perform some basic calculations on this worksheet’s data. For example, 

let’s calculate the sum of these numbers. To perform a calculation, you must first activate the cell 

where you want the calculation’s result to appear. Let’s make the result appear in this cell. Then, 

you must enter the appropriate formula for the calculation in the cell. 

 

The formula for the sum of these numbers would simply be the first number, plus the second 

number, plus the third number. Before entering a formula, you must first type in an Equal sign in 

the cell. The Equal sign indicates that the cell will contain a formula, not regular data. After the 

Equal sign, type in the formula, and then press the Enter key. The formula’s result will appear in 

the cell. 

 

Let’s enter a label in this cell to indicate what this calculation result represents. 

 

Now, let’s enter another formula to calculate the sum of these numbers. Again, first activate the 

cell where you want the result to appear, for example this cell, and then enter the appropriate 

formula in it. Instead of using the actual numbers in the formula, you can simply use the cell 

references of the cells containing the numbers. Excel will automatically use the numbers in the 

referenced cells to perform the calculation. As before, first enter an Equal sign in the result cell. 

Then enter the formula. After you type in the first cell reference's letter, a list of functions, 

starting with that letter will be displayed. Functions are preset formulas that you can use to 

perform a variety of calculations. They'll be discussed later in the "Functions" lesson. Simply 

ignore the list and continue typing. When you type in the cell reference, it  will appear in color, 

and a border of the same color will appear around its corresponding cell. Simply continue typing 

the rest of the formula, and then press the Enter key. The result will appear in the cell. 

 

A formula that uses cell references provides an important benefit, over one that uses actual 

numbers. If you modify the contents of a cell included in a formula that uses cell references, for 

example this cell, the calculation’s result will be automatically updated. However, if you change 

the contents of a cell, included in a formula that uses actual numbers, for example this cell, the 

number entered in the formula won’t change. Therefore, the formula’s result will remain the 

same as before, not reflecting the change that you made to the cell. For this reason, you should 

use cell references instead of actual numbers in a formula. 
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Let’s modify the formula in this cell to use cell references instead of actual numbers. To modify 

a formula, first select its cell. The formula will appear in the formula bar. Then, simply make the 

desired changes to the formula. Let’s replace these numbers with their corresponding cell 

references. Once you’ve made your changes, simply click on the Enter button. The formula’s 

result will be displayed.  

 

Besides addition, you can also perform other calculations such as subtraction, multiplication, and 

division using their appropriate arithmetic operators. 

 

Let’s use subtraction to calculate the difference between these two numbers. As before, first 

activate the cell where you want the calculation’s result to appear, for example this cell. Then 

enter the appropriate formula in it. As mentioned earlier, you should use the cell references, 

corresponding to the actual numbers. Again, enter the formula in the result cell, starting with the 

Equal sign. Instead of typing in a cell’s reference, you can simply click on the cell. The cell’s 

reference will be automatically entered in the formula. Then type in the next part of the formula, 

and again click on the appropriate cell. The cell’s reference will be added to the formula. Once 

the formula has been completed, press the Enter key. The result will be displayed. 

 

Let’s enter a label in this cell to indicate what this calculation result represents. 

 

B1.10 Functions  

 

Excel provides a useful feature, referred to as Function that lets you quickly perform common 

calculations, such as sums and averages, without having to enter formulas. 

 

Let’s use a function to calculate the sum of these numbers. You can easily enter the sum of the 

numbers in the cell immediately below them, by first activating the cell. Then click on the left 

part of the "AutoSum" button in the "Editing" group, of the "Home" tab. The Sum function will 

appear in the cell. A description of the function’s format is displayed below it. By default, the 

consecutive group of cells containing numbers, located above the function, is included in it. The 

cell references of the first and last cell in the group separated by a colon are displayed inside the 

function, indicating this cell range will be included in the sum. Simply click on the "Enter" 

button. The sum will appear in the cell. 
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Now let’s use the Sum function, to calculate the sum of these numbers. You can enter the sum in 

any cell you want, for example this cell, by first activating it. Then click on the "AutoSum" 

button. Again, the Sum function will appear in the cell, and the group of cells above it, will be 

automatically included in it. You can replace these cells with the cells that you want to include in 

the sum by simply dragging over them. The cells will be included in the sum. Then, click on the 

"Enter" button. The result will be displayed. 

 

Let’s enter a label in this cell to indicate what this calculation result represents. 

 

Now, let’s use a function to calculate the average of these numbers. Again, first activate the cell 

where you want the result to appear, for example this cell. Then, click on the down arrow on the 

right of the AutoSum button. A menu containing the list of standard functions will be displayed. 

Select Average from the list. The "Average" function will appear in the result cell, with the cells 

above it, included in it. As before, replace these cells with those you want to include in the 

average by simply dragging over them. The cells will be included in the function. Then click on 

the Enter button. The result will be displayed. 

 

Let’s enter a label in this cell to indicate what this calculation result represents. 

 

In addition to the Sum and Average functions, Excel provides many other useful functions. The 

Frequently Asked Questions of this section provides information on some of the other commonly 

used functions. 

 

B1.12 Saving Workbooks 

 

You must save your workbook as a file, to prevent its contents from being lost, when you exit 

Excel, or turn off the computer.  

 

Let’s save the workbook that we created earlier. To save a workbook, click on the "Save" button 

in the "Quick Access" toolbar. If you’re saving a workbook for the first time, the "Save As" 

dialog box will appear. The dialog box contains an address bar that lets you select a location for 

saving the workbook. The default saving location is the current user’s "Documents" folder. Let’s 

save the workbook in this location. 

 

Before saving the workbook, enter a name for it in the text box labeled "File name." By default, 

Excel sets a new workbook’s file name to the word "Book" followed by a number, but you can 

give the workbook any file name you like. You should give workbooks unique file names so you 

can easily identify them later. For example, let’s give the workbook, this name. 
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The "Save as" dialog box also contains a drop down list labeled "Save as type" that lets you 

select a file type for the workbook you’re saving. The default type for files created in Excel 2007 

is "Excel Workbook" with the extension dot-xlsx. Let’s leave the "Save as type" unchanged so 

the file is saved with this type. Once you’ve specified the desired save parameters, click on the 

"Save" button. The workbook will be saved in a file as specified. 

 

Now let’s make a change to the workbook, for example modify this number. The changes in the 

workbook won’t be reflected in the file until you save the workbook again. To save the changes, 

simply click on the "Save" button. The workbook’s new contents will be saved in the file.   

 

Now, let’s make a change to the workbook, for example, change this number. Sometimes, after 

you modify a workbook, you may want to save it as a new file without replacing the original file.  

 

To save a workbook as a new file, first click on the "Office" button, and then move the mouse 

pointer over "Save As." A list of different file formats for saving a copy of the worksheet will be 

displayed. Let's select the default format, "Excel Workbook." The "Save As" dialog box will 

open with the location, File name, and Save as type set to those of the original file. 

 

You don’t always have to save the file in the current Save-in location; you can save it anywhere 

you want. For example, let’s save the file in the Business folder, inside the Temp folder, on the C 

drive. To set the Save-in location to a particular folder, you must first select the drive where it 

resides, and then go down the path to that folder. The "Favorite Links" on the left of the dialog 

box displays the list of commonly used locations. Click on "Computer" to display the computer’s 

contents. Then open the C drive by simply double clicking on it. The drive’s contents, including 

the "Temp" folder will appear. Now, open the "Temp" folder. The folder’s contents, including 

the "Business" folder will be displayed. Then, open the "Business" folder. The Save-in location 

will be set to this folder. 

 

Before saving the file, change its name so it can be distinguished from the original file. Let’s 

change the file’s name to this name. Also, let’s change its file type, to this type, so it can be 

opened by previous versions of Excel. Simply open the "Save as type" drop-down list, and select 

the desired file type. Now, click on "Save." The workbook will be saved in a new file as 

specified, and the original file will remain untouched. 

 

Once you’ve saved the workbook, you can close it by clicking on the workbook's "Close" button, 

located below the Program window's close button. 
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B1.15 Creating New Workbooks 

 

You can create a new workbook inside Excel, by first clicking on the "Office" button. Then 

select "New." The "New Workbook" dialog box will open. The dialog box provides a list of 

templates that you can use to create a new workbook. By default, the "Blank and recent" group of 

templates is selected, with "Blank Workbook" selected by default. Simply click on the "Create" 

button. A blank workbook will be created. You can then enter the desired data in the workbook.  

 

Now, let’s save the workbook by clicking on the "Save" button on the "Quick Access toolbar." 

Since this is a new workbook, the "Save As" dialog box  will open to let you specify a name and 

location for saving the file. Let’s enter a file name for the workbook, and save it in the default 

location, by simply clicking on "Save." Once the workbook has been saved, you can close it. 

 

B1.17 Opening Workbooks 

 

You can open a previously saved workbook, by first clicking on the "Office" button. A list of the 

workbooks that you have recently worked on will be shown under "Recent Documents." You can 

open one of these workbooks, for example this one, by simply selecting it from the list. The 

workbook will open. 

 

Now let’s open another workbook. Again, first click on the "Office" button. If you want to open 

a workbook that’s not included in the "Recent Documents" list, click on "Open." The "Open" 

dialog box will appear to let you locate the desired workbook. The default location is the current 

user’s "Documents" folder. The folder’s contents are displayed in the dialog box’s main pane. 

 

Let’s open a workbook in a different location. For example, let’s open this workbook, located in 

this folder, inside the "Temp" folder, on the C drive. First, click on "Computer" under "Favorite 

Links " to display the computer’s contents. The computer’s disk drives including the C drive will 

be displayed. Double-click on the C drive to open it. The drive’s contents, including the "Temp" 

folder, will appear. Now, open the "Temp" folder. Its contents, including the "Business" folder 

will appear. Then, open the "Business" folder. The folder’s contents will appear. Here is the file 

that was saved in this location. You can open the file by simply double clicking on it.  The 

workbook will be displayed. Now, let’s exit Excel so I can show you another way to open a 

workbook. 

 

For example, let’s open this workbook, stored in the "Documents" folder. You can also open a 

workbook using its icon without first starting Excel. To locate this workbook’s icon, you can 

simply click on the "Start" button, and select "Documents." The Windows Explorer window will 
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open, displaying the contents of the Documents folder. Here’s the icon of the workbook we want 

to open. You can simply double-click on the icon to open the workbook. Excel will automatically 

start and open the workbook. 

 

B1.20 Fonts 

 

In this lesson, I’ll teach you how to use fonts to make your worksheet look more attractive. 

 

Let’s change some of the fonts in this worksheet to make it look more attractive. You can set the 

fonts in a worksheet, using the functions in the "Font "group of the "Home" tab. For example, 

let’s change this text’s font. To change the font of a cell’s contents, first select the cell. Then, 

open the "Font" drop-down list. The list displays the available fonts in alphabetical order. Select 

the desired font, for example this one. The text will appear in the font you selected. 

 

Now let’s change the font size of the text. You can enter the desired size in the "Font Size" box, 

or open the Size drop-down list, and simply select a size from the list, for example this one. The 

text will appear in the size you selected, and the height of the row containing the text will 

automatically change to fit the new size. 

 

Now let’s apply a font style to another part of the worksheet, for example this text. Again, first 

select the cell containing the text. You can set the desired style using the "Style" buttons. These 

buttons include" Bold," "Italic," and "Underline." Let’s select "Bold", and "Italic." The text’s 

style will change to what you selected. 

  

Now, let’s change the font settings, of this cell. Once again, first select the cell. Then make the 

desired font selections. For example let’s increase the font size of the text. Another way to 

change the font size is by using the "Increase Font Size" or "Decrease Font Size" buttons. You 

can click on the "Increase Font Size" button to make the text larger, or click on the "Decrease 

Font Size" button to make it smaller. 

 

You can also underline the text by clicking on the "Underline" button. You can change the 

underline style by first clicking on the arrow next to the "Underline" button. The list of underline 

styles will open. The default selection is single underline. You can also apply double underline to 

the text. Let's leave the underline style unchanged. The cell’s contents will appear as specified. 

 

You can also make the text appear in color, by first clicking on the arrow next to the "Font 

Color" button. The gallery of colors will open. The default selection is "Automatic," which 
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normally corresponds to black. You can select any color that you like, for example this one. The 

font will appear in the selected color. 

 

B1.22 Alignment 

 

You can change the alignment of data within a cell. You can align the data vertically in three 

ways. You can align it at the top of the cell, in the middle of the cell, or at the bottom of the cell 

 

You can also align the data horizontally in three ways. You can align it to the left of the cell, in 

the middle of the cell, or to the right of the cell. 

 

By default, text is aligned at the bottom left of the cell, and numbers are aligned at the bottom 

right of the cell. 

 

You can change the alignment of a cell's data, using the buttons in the "Alignment" group, of the 

"Home" tab. The top row of buttons lets you set the vertical alignment, and the bottom row of 

buttons lets you set the horizontal alignment. For example, you can align this cell’s text to the 

right, by first selecting it. Then simply click on the "Align Right" button. The text will be aligned 

as specified. 

 

Now let’s set the vertical alignment of the data in these cells to the middle. First select the cells 

by dragging over them. Then click on the "Middle Align" button. The cells' contents will be 

aligned as specified. 

 

You can also center data across several cells. For example, you can center this text, across these 

cells. Simply select the cells by dragging over them, and then click on the "Merge and Center" 

button, in the "Alignment" group. The text will be centered across the cells. 

 

B1.24 Number Formats 

 

You can change the number format of the numbers in a spreadsheet to make them appear in 

different ways. For example, you can make a number appear with thousand separator commas, as 

dollars and cents, or as a percentage. 

 

Let’s make the numbers in these cells, appear with thousand separator commas. To change the 

number format of one or more cells, first select them. You can select a group of cells by simply 

dragging over them. Then click on the "Comma Style" button, in the "Number" group, of the 

"Home" tab. The selected numbers will appear in the specified format. By default, the numbers 
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will contain 2 decimal places. You can change the number of decimal places using the "Increase 

Decimal", and "Decrease Decimal" buttons, in the "Number" group. Let’s click on the "Decrease 

Decimal" button to make the numbers appear without decimals. The numbers will appear as you 

specified. 

 

Now, let’s make these numbers appear as dollars and cents. Again, first select the numbers. Then 

simply click on the "Accounting Number Format" button in the "Number" group. The numbers 

will appear in the specified format.  

 

Now let’s make this number appear as a percentage. Once more, first select the number. Then 

click on the "Percent Style" button in the "Number" group. The number will be displayed as a 

percentage with a percent sign after it. Let’s click on the "Increase Decimal" button to add one 

decimal place to the percentage. The number will appear as you specified. 

  

Excel provides other number formats that you can apply to the worksheet's data. If you open the 

"Number Format" drop-down list in the "Number" group, the list of all available number formats 

will be displayed. You can apply any of these formats to the data in your worksheet. 

 

B1.26 Format Painter 

 

Excel provides a useful feature, referred to as Format Painter that lets you apply the format of a 

cell to other cells. 

 

Let’s apply the format of some of the cells in this worksheet to other cells. For example, let’s 

apply the font settings of this cell, to this one. To apply the format of a cell, first select it. Then 

click on the "Format Painter" button, in the "Clipboard" group, of the "Home" tab. A dashed line 

will appear around the cell, indicating its format has been copied. If you move the mouse pointer 

inside the worksheet, it will change to a "Cross", with a paintbrush next to it, indicating the 

Format Painter is active. You can then apply the copied format, to the desired cell, by simply 

selecting it with the Paintbrush pointer. The cell’s format will change, to the format of the other 

cell, and the pointer will change back to a normal cross indicating the Format Painter is no longer 

active.  

 

Now, let’s apply the cell’s format, to these cells as well. You can apply the format to multiple 

cells, without having to activate the Format Painter more than once. Simply double click on the 

"Format Painter" button, instead of single clicking on it. As before, the cell’s format will be 

copied, and if you move the pointer inside the worksheet, it’ll change to the paintbrush pointer. 

You can then apply the format to one of the desired cells, for example this one, by clicking on it. 
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The format will be applied to the cell. This time however, the Format Painter will remain active 

to let you apply the format to other cells. You can then apply the format to the desired cells, by 

simply clicking on each one. Once you’ve applied the format to the cells that you want, you can 

deactivate the Format Painter by clicking on its button. 

 

You can also use the Format Painter to apply a cell’s number format to other cells. For example 

let’s apply this cell’s currency format, to these cells. Again, first select the cell, and then click on 

the "Format Painter" button. The cell’s format will be copied, and the Format Painter will 

become active. You can apply the copied format to a group of cells, by simply dragging the 

Paintbrush pointer over them. The format will be applied to the cells. 

 

B1.28 Resizing Rows and Columns 

 

You can resize the rows and columns of your worksheet to make it look better and easier to read.  

Let’s resize some of the rows and columns in this worksheet. For example, let’s change this 

row’s height. You can easily change a row’s height, by first placing the mouse pointer over the 

bottom border of the row’s number. The pointer will change to a "vertical double sided arrow" 

with a horizontal line in the middle. You can then drag the row’s edge to change its height. When 

you press the mouse, the row’s height will appear. The height is displayed in two units. The first 

unit is "Points" and the second unit is "Pixels." These units are described in the Frequently Asked 

Questions of this section. You can simply drag the row’s edge to the desired height, and release 

the mouse button. The row’s height will be set to what you specified. 

 

Now let’s change this row's height. Another way you can change a row’s height, is to first select 

it by clicking on its number. The row will be highlighted. Then, click on the "Format" button, in 

the "Cells" group, of the "Home" tab, and select "Row Height" from the menu. The "Row 

Height" dialog box will appear, with the row’s height displayed in a text box. The height’s unit is 

"Points." Enter the desired height in the text box, for example this height, and then click on 

"OK." The row’s height will be set as specified. 

 

Now let’s change the width of a column, for example this one. You can easily change a column’s 

width, by first placing the mouse pointer over the right border of the column’s letter. The pointer 

will change to a horizontal double sided arrow with a vertical line in the middle. You can then 

drag the column’s edge to change its width. When you press the mouse, the column’s width will 

appear. The width is displayed in two units. The first unit is "Number of Characters," and the 

second unit is "Pixels." These units are described in the Frequently Asked Questions of this 

section. You can simply drag the column’s edge to the desired width, and release the mouse 

button. The column’s width will be set to what you specified. 
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Now, let’s change this column’s width. Another way you can change a column’s width, is to first 

select it by clicking on its letter. The column will be highlighted. Then, click on the "Format" 

button, and select "Column Width" from the menu. The "Column Width" dialog box will appear, 

with the column’s width displayed in a text box. The unit of the width is number of characters. 

You can enter the desired width, for example this width, and then click on "OK." The column’s 

width will be set as specified. 

 

You can also adjust the width of a column, for example this one, to exactly fit the widest data in 

it. First select the column. Then click on the "Format" button, and select "AutoFit Column 

Width" from the menu. The column’s width will be adjusted to exactly fit its widest data. 

 

Now let's adjust this column's width to exactly fit its widest data. Another way you can adjust a 

column's width to fit its data, is to first place the mouse pointer over the right border of the 

column’s letter. Then simply double click. The column’s width will be adjusted to exactly fit its 

data. 

 

B1.30 Printing 

 

Excel lets you easily print your worksheet, provided you have a printer properly set up and 

connected to your computer. 

 

Before printing a worksheet, you can preview how it will appear in print, by first clicking on the 

"Office" button. Then move the mouse pointer over "Print." A list of print options will be 

displayed. Select "Print Preview" from the list. The worksheet will appear the way it would be 

printed. It will be displayed in reduced size, so you can view the whole page. Once you’ve 

finished previewing the worksheet, click on the "Close Print Preview" button on the toolbar to 

exit Print Preview. 

 

You can quickly print a copy of the worksheet, by first opening the "Office" menu. Again move 

the mouse pointer over "Print" and select "Quick Print." A copy of the worksheet will be printed. 

 

Another way you can print the worksheet is to first open the "Office" menu, and then click on 

"Print." The "Print" dialog box will appear. This dialog box provides various settings to let you 

specify how you want to print the worksheet. 

 

The dialog box’s "Printer" area displays information about the printer that would be used for 

printing the worksheet. 
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If the worksheet's printout consists of multiple pages, you can use the options in the "Print range" 

area to specify which pages you want to print. By default, all pages will be printed. The "Pages 

From" option allows you to print specific pages. This worksheet's printout has only one page, so 

let’s use the "All" option.  

 

The "Print what" area contains options that let you specify which parts of the workbook you want 

to print. The default option is "Active sheets" meaning all the selected worksheets will be 

printed. The "Selection" option will only print the cells that are selected, and the "Entire 

workbook" option will print all the worksheets in the workbook.  Let’s use the default option. 

   

The "Copies" area contains a "Number of copies" text box where you can enter how many copies 

you want to print. By default, one copy will be printed, but you can print any number of copies 

you want. Let’s print two copies. 

  

Once you’ve specified the desired print options, click on "OK." The worksheet will be printed as 

you specified. 

 

B1.33 Office Clipboard 

 

To use the "Office Clipboard," first click on the "Dialog Box Launcher" in the "Clipboard" 

group, of the "Home" tab. The "Clipboard" pane will open. The pane displays the list of items 

that you recently moved or copied. You can easily paste any of these items in the worksheet. 

First, select the cell where you want to paste the item, and then simply click on the item in the 

clipboard. The item will be pasted at the specified location. 

 

The "Clipboard" pane also contains two buttons at the top: "Paste All" and "Clear All." You can 

use the "Paste All" button to paste all the items in the clipboard into your worksheet at once, and 

you can use the "Clear All" button to erase all the items in the clipboard. 

 

To close the "Clipboard" pane simply click on its "Close" button. 

 

B1.35 Getting Help 

 

Excel provides help information on how to use its various functions. You can access the help 

information, either by clicking on the Help button on the right side of the Ribbon, or by pressing 

the F1 key on the keyboard. Let's click on the Help button. The help window will open. The list 

of help categories is displayed under "Browse Excel Help." Select the desired category, for 
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example this one. The list of topics in that category will be displayed. Then select the desired 

topic, for example this one. The help information about the topic will be shown. 

 

The help window also contains a search box that lets you find help information on a specific 

topic. Simply type in the desired topic in the search box, for example this one. Then click on 

"Search." A list of tasks related to the topic will be displayed. Click on the desired task, for 

example this one. The help information about the task will be shown. 

 

The help window also contains several useful buttons.  

 

The "Back" and "Forward" buttons let you go back and forth between the help pages that you’ve 

already viewed. 

 

The "Stop" and "Refresh" buttons apply to accessing help information from the Internet. Excel 

2007 may load some up-to-date help information from Microsoft’s web site on the Internet. The 

"Stop" button allows you to stop the loading of a help page, and the "Refresh" button lets you 

reload a help page. 

 

The "Home" button displays the main help page containing the help categories. 

 

The "Print" button lets you print the contents of the help window. 

 

The "Change Font Size" button lets you change the size of the text in the help window. If you 

click on this button, a list of available sizes will be displayed. Simply select the desired size, for 

example this one. The text size will change to what you specified. 

 

The "Table of Contents" button provides you with a different way to access the help information. 

If you click on this button, the "Table of Contents" pane will appear, displaying the list of help 

categories. You can then select the desired category, for example this one. The topics in the 

category will be displayed under it. Then select the desired topic, for example this one. The 

information about the topic will be displayed. 

 

The "Keep On Top" button lets you specify whether the help window always appears on top of 

the main Excel window, or can be moved to the back. By default, the help window always 

appears on top. 

 

Once you’re done working with the help window, you can close it. 
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B1.38 Unit 1 End 

You've reached the end of unit 1. Here is a summary of what you learned in this unit. You 

learned how to: 

 

 Identify elements of the Excel window 

 Enter data in a worksheet's cells 

 Select, cut, copy, paste, modify and delete data 

 Enter formulas using arithmetic operators 

 Enter cell references in formulas 

 Use the Sum and Average functions 

 Save workbooks in different locations 

 Create new workbooks 

 Open existing workbooks 

 Change the font type, size, style and color of data 

 Align data in cells 

 Change the number format of data 

 Copy data formats using the Format Painter 

 Resize a worksheet's rows and columns 

 Preview and print a workbook 

 Paste copied items using the Office Clipboard 

 and Use Excel's online help 
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Unit 2 

 
B2 Unit 2 

 

In this course, you'll learn how to: 

 

 Fill Cells with Data 

 Move and Copy Data Efficiently 

 Insert and Delete Cells 

 Insert and Delete Rows 

 Insert and Delete Columns 

 Correct Data Fitting Errors 

 Perform a Spelling Check 

 Find and Replace Data 

 Specify Order of Operations 

 Use Common Functions 

 Insert Functions in Formulas 

 Modify Formulas and Functions 

 Copy Formulas and Functions 

 Find and Correct Formula Errors 

 Organize Worksheets 

 Work with Multiple Worksheets 

 Create Worksheets Using Templates 

 and Save a Worksheet in Different Formats 

 

B2.1 Filling Cells 

 

Excel provides a "Fill" function that lets you enter data in several cells at once. You can fill cells, 

with the same data, or a series of data such as: 

 

 text 

 numbers 

 text and numbers 

 dates 

 or times 

 

Let’s use the "Fill" function to enter some data in this worksheet. For example, let’s fill these 

cells, with this data. You must begin by entering the data, in the first cell of the group you want 
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to fill. Then select all the cells in the group, including the first cell by dragging over them. Now 

click on the "Fill" button, in the "Editing" group, of the "Home" tab. A menu containing different 

fill options will be displayed. Since the cells we want to fill, are below the one containing the 

data, we need to select the "Down" option. The cells will be filled with the data. 

 

Now let's fill these cells, with this data. Again, enter the data, in the first cell of the group. 

Another way you can use the "Fill" function is by first placing the mouse pointer, over the little 

marker on the lower right corner of the cell, referred to as the "Fill Handle." The pointer will 

change to a Plus sign. Simply drag the pointer over to the last cell in the group, and release the 

mouse button. The cells will be filled with the data. In addition, a button referred to as "Auto Fill 

Options" will appear on the lower right of the cells. This button lets you modify the filled cells’ 

contents and appearance. Simply ignore the button to keep the cells unchanged. 

 

Now, let’s go to another worksheet and fill some of its cells. For example, let’s fill these cells, 

with this text series. You must begin with entering the first text of the series in the first cell of the 

group you want to fill. Again, place the mouse pointer over the "Fill Handle." The pointer will 

change to the Plus sign. Then simply drag the pointer over to the last cell in the group, and 

release the mouse button. The cells will be filled with the text series. 

 

Now, let’s go to another worksheet, and fill some of its cells. For example, let’s fill these cells, 

with this number series. To fill cells with a number series, you must begin by entering the first 

two numbers in the series, into the first two cells of the group. You need to enter two numbers, 

so the "Fill" function can determine the increment for generating the next numbers in the series. 

After you’ve entered the first two numbers, select both by dragging the mouse pointer over them. 

Then, simply drag the "Fill Handle" over to the last cell in the group, and release the mouse 

button. The cells will be filled with the number series.  

 

B2.3 Moving and Copying Data Efficiently 

 

In this lesson, I’ll teach you various efficient ways to move, copy, and delete data. 

 

You can move and copy data by simply dragging it from one cell to another. Let’s move this 

cell’s data, to this cell. To move a cell’s data, first select the cell. Then, place the mouse pointer 

over the cell’s border. The cross will change to a regular pointer with a four sided arrow under it. 

Then simply drag the data to the desired cell, and release the mouse button. The data will be 

moved to the cell. 
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You can move and copy data by simply dragging it from one cell to another. Let’s move this 

cell’s data, to this cell. To move a cell’s data, first select the cell. Then, place the mouse pointer 

over the cell’s border. The cross will change to a regular pointer with a four sided arrow under it. 

Then simply drag the data to the desired cell, and release the mouse button. The data will be 

moved to the cell. 

 

Now let’s copy data, for example from this cell, into this cell. Again, first select the cell 

containing the data. Then place the pointer over the cell’s border. To copy the data, you must 

press and hold down the Control key. A Plus sign will appear next to the pointer, indicating the 

data will be copied, not moved. Then simply drag the data to the desired cell, and release the 

mouse button. The data will be copied in the cell. 

 

You can easily delete, move, or copy the data in a group of cells. For example, let’s delete the 

data in these cells. To delete the data in a group of cells, first select them by dragging over them, 

and then press the Delete key. The cells’ data will be deleted. 

 

Now let’s move the data in a group of cells, for example these cells. Again, first select the cells 

by dragging over them. Then, place the mouse pointer over the cells’ border, and drag them to 

the desired location, for example these cells. A gray border will mark the cells where the data 

will be placed. Simply release the mouse button. The data will be moved to the cells.  

 

Now let’s copy the data in a group of cells, for example these cells. Once again, first select the 

cells, and then place the mouse pointer over their border. To copy the cells, you must press and 

hold down the Control key. A Plus sign will appear next to the pointer, indicating the data will be 

copied. Then drag the cells to the desired location, for example here, and release the mouse 

button. The data will be copied to the cells. 

 

You can also move and copy the data in an entire row or column. For example, you can move the 

data in this row, by first clicking on its number to select it. You can then move its data using cut 

and paste or by dragging. Let's drag the data by first placing the mouse pointer over the row's 

border. Then drag it to the desired row, for example this one. 

 

Now, let's copy the data in this column. Again, first select the column by clicking on its letter. 

Then copy its data using copy and paste or by dragging. Let's click on the Copy button to copy 

the data. Then, select the column where you want to paste the data, for example this one, and 

click on the Paste button. The data will be copied there. 
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B2.5 Inserting and Deleting Cells 

 

You can insert a new cell in the middle of cells that contain data. For example, let’s insert a cell 

here. First select the location where you want the new cell to appear. Then, simply click on the 

"Insert" button, in the "Cells" group, of the "Home" tab. A blank cell will be inserted at the 

current location, and the cell that was there before, plus those below it will be shifted down. You 

can then enter the desired data in the new cell. 

 

Now, let's insert a cell here. You can also insert a cell, by shifting the cell at the current location, 

and those to its right, one cell to the right. Again, first select the desired cell. This time, click on 

the arrow to the right of the "Insert" button, and select "Insert Cells" from the menu. The "Insert" 

dialog box will open, displaying options for shifting the existing cells to create room for the new 

cell. Select the "Shift cells right" option, and click on "OK." A blank cell will be inserted at the 

current location, and the cell that was there before, plus those to its right, will be shifted to the 

right. You can then enter the desired data in the new cell. 

 

Now, let’s delete a cell, for example this one. Deleting a cell, is different from deleting a cell’s 

data. Deleting a cell, may shift some of the cells around it. However, deleting a cell’s data, does 

not affect the other cells.  

 

To delete a cell, first select it. Then simply click on the "Delete" button, in the "Cells" group. The 

cell will be deleted, and the cells below it, will be shifted up. 

 

Now, let's delete this cell. You can also delete a cell, and shift the cells to its right, one cell to the 

left. Again, first select the desired cell. This time, click on the arrow to the right of the "Delete" 

button, and select "Delete Cells" from the menu. The "Delete" dialog box will open, displaying 

options for adjusting the other cells after the selected cell is deleted. Select the "Shift cells left" 

option, and click on "OK." The cell will be deleted, and the cells to its right, will be shifted to the 

left. 

 

B2.7 Inserting and Deleting Rows and Columns 

 

You can easily insert a new row or column in your worksheet. For example, let’s insert a row 

here. First click on the row number where you want the new row to appear. The row will be 

selected. Then click on the "Insert" button, in the "Cells" group, of the "Home" tab. A blank row 

will be inserted at the current location, and the row that was there before, plus those below it, 

will be shifted down. You can then enter the desired data in the new row. 
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Now let’s insert a new column here. First click on the column letter where you want the new 

column to appear. The column will be selected. Then simply click on the "Insert" button. A blank 

column will be inserted at the current location, and the column that was there before, plus those 

to its right, will be shifted to the right. 

 

Now let’s delete a row, for example this one. As before, first select the row, by clicking on its 

number. Then click on the "Delete" button, in the "Cells" group. The row will be removed, and 

the rows below it, will move up. 

 

Now, let’s delete a column, for example this one. Again, first select the column, by clicking on 

its letter. Then simply click on the "Delete" button. The column will be removed, and the 

columns to its right, will move to the left. 

 

B2.9 Data Fitting Errors 

 

A data fitting error can be produced by a number that’s too long to fit in a cell. For example, if 

you add a digit to this number, a sequence of number signs will appear in the cell. The number 

signs indicate that the number in the cell doesn’t fit. 

 

You can easily correct this error by increasing the width of the column to fit the number. The 

number will then appear correctly. 

 

A data fitting error can also be produced when the text is too long to fit in a cell, and the cell to 

the right contains data, preventing the text from spilling into it. For example, if you make this 

cell’s text longer by adding a word before it, only the part of the text that fits in the cell will be 

visible. The rest of the text will be covered by the next cell. 

 

You can correct this error by either increasing the column’s width to fit the text, or by moving 

the data in the next cell to uncover the part of the text that’s hidden. Let’s move the cell’s data. 

The whole text will become visible. 

 

B2.11 Spelling Check 

 

You can use the "Spelling" function to easily find and correct the spelling errors in your 

worksheet. To use the "Spelling" function, first click on the "Review" tab, and then click on the 

"Spelling" button, in the "Proofing" group. The "Spelling" dialog box will open, and the first 
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spelling error in the worksheet will be found. The error will be displayed in a box at the top of 

the dialog box, and a list of suggestions for correcting the error will be displayed below it. Select 

the appropriate correction, which in this case would be this word. Then click on "Change." The 

error will be replaced with the selected correction, and the next error in the worksheet will be 

found. 

 

Again, the error will be displayed in the dialog box, along with a list of suggested corrections. 

The appropriate correction for this error is already selected. If the error exists in more than one 

place, you can correct all the instances of the error at once, by simply clicking on "Change All". 

All instances of the error will be corrected. 

 

Once there are no more spelling errors in the worksheet, a dialog box will open, indicating "The 

spelling check is complete for the entire sheet." Simply click on "OK" to close the dialog box. 

 

B2.12 Find and Replace 

 

You can easily find and replace specific items in a worksheet. To find an item, first click on the 

"Find & Select" button, in the "Editing" group, of the "Home" tab, and then select "Find" from 

the menu. The "Find & Replace" dialog box will open. Enter the item that you'd like to find, in 

the "Find what" box. For example, let’s find this word. Once you’ve entered the desired text, 

click on "Find Next" to search for the word starting from the selected cell. The first instance of 

the word will be found. To find the word's next instance, simply click on "Find Next" again. The 

next instance will be found. You can find the other instances of the word in the same way. 

 

You can easily replace the word found with a different word. For example, let's replace the word 

with this one. First click on the "Replace" tab. The "Replace" panel will move to the front. The 

panel contains the "Find what" box that also appeared in the "Find" panel, and another box 

labeled "Replace with." Enter the new word in this box. You can then click on "Replace" to 

replace only the current instance of the word, or click on "Replace All" to replace all instances of 

the word in the worksheet. Let's click on "Replace All." The word will be replaced throughout 

the worksheet, and a dialog box will appear, indicating "Excel has completed searching the 

worksheet." The number of replacements made will also be shown. Simply click on "OK" to 

close the dialog box. 

 

Once you’ve found and replaced the desired items, close the "Find and Replace" dialog box. 

 

B2.15 Formulas Containing Multiple Operators 
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You can perform calculations, using formulas that contain multiple operators, such as addition, 

subtraction, multiplication, and division. 

 

Let’s enter a formula in this cell, to calculate the total discount, based on the data in these cells. 

The formula would consist of the sum of the prices multiplied by the discount rate. 

 

Excel performs the operations in a formula in a predefined sequence. Normally, it performs the 

operations from left to right. But if the formula contains different operators, the order of 

operations may change. By default, multiplication and division are performed before addition 

and subtraction. Therefore in this formula, these numbers would be multiplied first, and then 

added to these numbers. However, this order of calculation would not produce the desired result 

because it calculates the discount on only one of the prices, and then adds that discount to the 

other prices. The correct result would be obtained by adding all the prices first, and then 

multiplying the result by the discount rate. 

 

You can specify the desired order of calculation using parentheses. Simply put the operations 

that you want to be performed first, inside parentheses. Excel will perform those operations 

before others.  

 

Now, let’s enter the formula in the cell. As usual, in place of the actual numbers, you should use 

their cell references. The formula’s result will be displayed. 

 

B2.17 Commonly Used Functions 

 

In addition to the Sum and Average functions, Excel provides other commonly used functions 

including: 

 

 The "Count" function which returns the number of values in a list; 

 The "Max" function which returns the largest value in a list; 

 and the "Min" function which returns the smallest value in a list. 

 

Let's use the "Count" function to count the number of values in these cells. First, select the cell 

where you want the count to appear, for example this one. Then, click on the down arrow to the 

right of the "AutoSum" button, in the "Editing" group, of the "Home" tab. The menu of 

commonly used functions will be displayed. Select "Count Numbers" from the menu. The 

"Count" function will appear in the cell. By default, the cells containing values above the 

function will be included in it. You can replace these cells with those that you want to include in 
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the function by simply dragging over them. The cells will be included in the function. Then click 

on the "Enter" button. The number of values contained in the cells will be displayed. 

 

Now let’s use the "Max" function, to get the largest value contained in the cells. Again, first 

select the cell where you want the result to appear, for example this one, and click on the down 

arrow to the right of the "AutoSum" button. Then select "Max." The "Max" function will appear 

in the cell, with the cells above it included in it. As before, select the cells that you want to 

include in the function by dragging over them, and then click on the "Enter" button. The largest 

value in the cells will be displayed. 

 

Now let’s use the "Min" function, to get the smallest value contained in the cells. Once again, 

first select the cell where you want the result to appear, for example this one. Then click on the 

down arrow to the right of the "AutoSum" button, and select "Min." Now select the cells that you 

want to include in the function, and click on the "Enter" button. The smallest value in the cells 

will be displayed. 

 

B2.19 Inserting Functions in Formulas 

 

Excel lets you insert functions in a formula to make calculations easier. Let’s perform some 

calculations in this workbook by inserting functions in formulas. For example, let’s enter a 

formula in this cell to calculate the net profit based on these revenue and expense figures. 

 

The formula for the net profit would be the total revenue, minus the sum of the expenses. To 

enter this formula, first select the result cell, and type in the Equal sign. Then enter the revenue’s 

cell reference in the formula by clicking on its cell. Now, type in a minus sign. You can enter the 

sum of the expense cells after the minus sign by simply inserting the Sum function in the 

formula. 

 

To insert a function, first click on the "Insert Function" button on the Formula bar. The "Insert 

Function" dialog box will appear. This dialog box contains a search box that lets you find the 

desired function. It also provides a drop-down list containing the available function categories. 

The default category is the "Most Recently Used" functions. The functions in the category are 

displayed in the dialog box’s main pane. The Sum function is selected by default. Simply click 

on the OK button. The "Function Arguments" dialog box will appear to let you enter the desired 

values in the function. You must enter the values that you want to include in the sum, in the text 

box labeled "Number1." You can easily select the cells containing the values, by first clicking on 

the button to the right of the text box. The dialog box will be reduced to a text box, uncovering 

the worksheet. You can then select the cells that you want to include in the sum, by dragging 
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over them. The cells’ references will appear in the text box. Then click on the button to the right 

of the text box again. The whole dialog box will be displayed. Now click on "OK." The function 

will be inserted in the formula, and the formula’s result will be displayed in the result cell. 

 

Now, let’s go to another worksheet, and perform a calculation in it. For example, let’s enter a 

formula in this cell to calculate the total profit. 

 

You can easily perform this calculation by setting the formula to the sum of the revenues, minus 

the sum of the expenses. As before, first select the cell where you want to enter the formula, and 

then click on the "Insert Function" button. The "Insert Function" dialog box will appear, with the 

Sum function already selected. Simply click on "OK." The "Function Arguments" dialog box 

will appear to let you enter the values to include in the Sum. Click on the button to the right of 

the first text box. Select the desired cells, and click on the button to the right of the text box 

again. The whole dialog box will appear. Now, click on "OK." The function will be entered in 

the Formula bar. Now, type in a "Minus" sign after the function in the Formula bar, and then 

insert the second Sum function just like the first one. The function will be added to the formula, 

and the result will appear in the cell. 

 

B2.21 Modifying Formulas and Functions 

 

You can easily modify the formulas and functions in a worksheet. 

 

Let’s modify the formula in this cell. To modify a formula, first select its cell. The formula will 

appear in the Formula bar. If you click on the formula, the cells that are included in it will be 

highlighted. You can then make the changes you want to the formula. For example, you can add 

this cell’s data to the calculation, by first entering a Plus sign at the end of the formula. Then 

simply click on the cell. The cell will be added to the formula. Once you’ve made the desired 

changes, click on the "Enter" button. The new result will appear in the cell. 

 

Now let’s modify the function in this cell. Again, first select the cell. The function will appear in 

the Formula bar. If you click on the function, the cells included in it will be highlighted. Simply 

make the changes you want to the function by editing it in the Formula bar. For example, let’s 

remove this cell’s data from the function by changing the last cell reference, to this cell. As 

before, once you’ve made the desired changes, click on the "Enter" button. The new result will 

appear in the cell. 

 

Now let’s modify the function in this cell. Once more, first select the cell, and then make the 

desired changes to the function in the Formula bar. Again, if you click on the function, the cells it 
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includes will be highlighted. Let’s change the first cell in the function, to this cell. Sometimes 

after you’ve modified a calculation, you may not like the changes you made, and want to undo 

your changes. In such a case, you can simply click on the "Cancel" button. The original 

calculation and its result will be restored.  

 

B2.23 Copying Formulas and Functions 

  

You can copy a formula or function to perform the same calculation on different sets of data. 

 

Let’s copy one of the formulas in this worksheet, for example the formula in this cell. First, let’s 

select the cell to display the formula it contains. The formula will appear in the Formula bar. This 

formula performs a calculation, on these cells. You can perform the same calculation, on these 

cells, by copying the formula, into this cell. You can copy a formula like regular data using 

simple copy and paste. The result of the copied formula will be displayed. The copied formula 

will refer to the cells in its own row, instead of the cells in the original formula. This is because 

the formula's cell references are "Relative" meaning they change relative to the formula’s 

position. 

 

Now, let’s copy another formula, for example this one. If you display the formula, you’ll see that 

it includes these cells. Let’s copy the formula, into this cell. The copied formula will include 

these cells, instead of those in the original formula. However, the formula no longer produces the 

correct result, because the reference to this cell has changed to an empty cell. 

 

You can prevent a cell reference in a formula from changing when the formula is copied, by 

making it an "Absolute" cell reference. Let's select this formula again, and make this cell’s 

reference absolute so it won’t change when the formula is copied. To make a cell reference 

absolute, simply insert a Dollar sign, before the column letter, and insert another Dollar sign 

before the row number. The Dollar signs indicate that the cell reference’s column and row, 

should not change when the formula is copied. Now if you copy the formula again, the correct 

result will be displayed, because the relative reference has changed, from this cell, to this one, 

but the absolute cell reference, has remained the same as in the original formula.  

 

Now let’s copy these two formulas, into these cells as well. You can quickly copy the formulas, 

by first selecting them. Then simply drag the "Fill Handle" over the desired cells. The formulas 

will be copied into their respective cells. If you display one of the formulas, for example this one, 

you’ll see that its cell references have been modified to include the appropriate cells.  
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You can also copy functions the same way you copy formulas. For example, let's copy this 

function. Again first select the function. This function calculates the sum, of these cells. You can 

copy the function, into these cells, to calculate the sum of these cells. Simply drag the "Fill 

Handle "of the cell containing the function over the desired cells. The function will be copied in 

the cells. 

 

Sometimes you may want to copy the result of a formula or function and paste it in another cell 

as a number, not as a formula or function. For example, let's copy the result of the function in 

this cell, and paste its value here. First select the cell containing the function, and click on the 

Copy button. Then select the cell where you want to paste the function's result. Now, click on the 

bottom part of the Paste button, and select "Paste Values." The function's result will be entered in 

the cell as a number. If you look at the Formula bar, you can see that the cell contains a plain 

number, not a function. 

 

B2.25 Formula and Function Errors 

 

Excel will produce various errors when it can’t properly calculate the result of a formula or 

function. The following are some of the most common errors: 

 

The "Divide by Zero" error happens when the calculation contains a division by zero. For 

example, this formula produces a "Divide by Zero" error, because it divides a cell containing a 

number, by a cell containing zero. 

 

The "Invalid Name" error happens when the calculation contains an entry that Excel can't 

recognize. For example, this formula produces an "Invalid Name" error, because it contains an 

unknown entry. 

 

The "Error in Value" happens when the calculation contains a value with an incorrect data 

format. For example, this formula produces an "Error in Value", because it contains a sum that 

includes a text cell. 

 

The "Invalid Cell Reference" error happens when the calculation includes a cell that’s deleted 

from the worksheet. For example, this formula will produce an "Invalid Cell Reference" error, if 

one of the cells that it refers to, is deleted. This error would only be caused, by deleting the cell 

itself, not by deleting the cell’s data. 

 

The "Circular Reference" error happens when a calculation refers to itself. For example, this 

formula produces a "Circular Reference" error, because it includes its own cell reference. 
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You can identify and correct an error, for example this one, by first clicking on its cell. An error 

button will appear next to the cell. If you click on this button, a menu containing selections 

related to the error will be displayed. The error’s description is shown at the top, indicating this is 

a "Divide by zero" error. To correct the error, first select "Edit in Formula bar." The formula bar 

will be activated, and the cells included in the formula will be highlighted. If you look at the 

formula, you’ll see that it includes a division by a cell that contains zero. You can correct the 

error by changing the cell’s data to a non-zero value. The error will be corrected. 

 

Now let’s correct the error in this cell. Again, first select the cell, and then click on the error 

button. The error menu will appear, with the error’s description at the top, indicating this is an 

"Invalid Name error." As before, you can correct the error, by first selecting "Edit in Formula 

bar." The formula bar will be activated, and the cells included in the formula will be highlighted. 

If you look at the formula, you’ll see that it contains a cell reference with an invalid row. Simply 

modify the cell reference to make it refer to the appropriate cell. The error will be corrected.  

 

Excel also provides an "Error Checking" function that helps you find and correct errors in the 

worksheet. To use this function, first click on the "Formulas" tab. Then click on the "Error 

Checking" button, in the "Formula Auditing" group. The "Error Checking" dialog box will 

appear, and the next error cell in the worksheet will be selected. The error’s description is 

displayed in the dialog box, indicating this is an error in Value. To correct the error, first click on 

the "Edit in Formula bar" button. The Formula bar will be activated, and the cells in the formula 

will be highlighted. The formula contains a sum that includes this text cell. Simply remove the 

cell from the formula. The error will be corrected. 

 

You can continue to search for errors by clicking on the "Resume" button. The next error will be 

found. This error is an Invalid Cell Reference error, indicating that the formula refers to a cell 

that may have been deleted from the worksheet. As before, to correct the error, first click on 

"Edit in Formula bar." Then remove the invalid cell reference from the formula. The error will be 

corrected. 

 

Again, click on the "Resume" button. If the worksheet doesn’t contain any more errors, a dialog 

box will appear indicating: "The error check is complete for the entire sheet." Simply click on 

OK to close the dialog box. 
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B2.27 Organizing Worksheets 

 

In this lesson, I’ll teach you how to perform some basic worksheet management tasks, to 

organize multiple worksheets in a workbook. I’ll show you how to: 

 

 Rename worksheets 

 Rearrange worksheets 

 Insert and delete worksheets 

 and Refer cells in different worksheets 

  

Renaming Worksheets 

By default, Excel assigns the name "Sheet" followed by a number to each of the worksheets in 

the workbook. You can change the worksheets’ names to better reflect what they contain. For 

example, let’s change the name of the worksheet being displayed, to this name. To rename a 

worksheet, first double click on its name tab. The name will be highlighted. Then, type in the 

desired name, for example this one, and press the "Enter" key. The worksheet’s name will 

change to the name you entered. 

 

Now let’s rename this worksheet. Again, first double click on the worksheet’s name tab. Then 

type in the desired name, for example this one, and press the "Enter" key. The worksheet’s name 

will change to the name you entered. 

 

Rearranging Worksheets 

You can rearrange the worksheets to make them appear in the desired sequence within the 

workbook.  For example, let’s move this worksheet, to the first position in the workbook. You 

can move a worksheet, by simply dragging its name tab. When you press the mouse button, a 

little icon representing the worksheet will appear under the mouse pointer, and an arrow will be 

displayed above the tab, indicating where the worksheet will be placed. Drag the icon so that the 

arrow points to the desired location, and release the mouse button. The worksheet will move to 

that location.  

 

Inserting and Deleting Worksheets 

Excel lets you insert new worksheets in a workbook to enter additional data. To insert a 

worksheet, simply click on the "Insert Worksheet" tab. A blank worksheet will be added to the 

workbook. You can then enter the desired data in it. 

 

You can easily delete a worksheet from your workbook. For example, let’s delete this worksheet. 

To delete a worksheet, first click on its name tab. Then click on the arrow to the right of the 
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"Delete" button, in the "Cells" group, of the "Home" tab, and select "Delete Sheet" from the 

menu. A dialog box will appear warning you that the worksheet may contain data. To 

permanently delete the worksheet and its data, click on the "Delete" button. The worksheet will 

be deleted from the workbook. 

 

Refer Cells in Different Worksheets 

You can perform calculations using data contained in different worksheets. For example, let's 

add the total in this worksheet, to the total in this one, and enter the result in this worksheet. 

First, select the cell where you want the result to appear, for example this cell, and enter the 

"Equal" sign to start a formula. Then go to the first worksheet, and click on the desired cell. The 

cell's reference will be entered in the formula, with the worksheet's name before it to indicate the 

cell belongs to this worksheet. Now type in the "Plus" sign in the formula. Then go to the second 

worksheet, and click on the desired cell. Again, the cell's reference will be entered in the 

formula, with the worksheet's name before it. Now, simply click on the Enter button. The 

formula's result will be entered in the worksheet containing the formula. Let's enter a heading in 

this cell to indicate what this data represents. 

 

B2.29 Templates 

 

Excel provides a variety of pre-formatted, ready-to-use worksheets, referred to as "Templates." 

You can use templates to easily create common worksheets, such as an invoice, timecard, 

expense statement, or balance sheet. 

 

To create a worksheet based on a template, first click on the "Office "button, and then select 

"New." The "New Workbook" window will open. This window, displays a list of template 

groups. The "Blank and Recent" group contains the recently used templates. The "Installed 

Templates" group contains all the templates installed on the computer. The "My templates" 

group contains the templates that you create yourself. "New from existing" lets you create a new 

template from an existing workbook. In addition, there are several template groups under 

Microsoft Office Online. Each group contains a variety of templates that you can download from 

Microsoft’s web site on the Internet. 

 

Let’s select "Installed Templates" to see the templates installed on the computer. The list of all 

installed templates will be displayed. You can scroll through the list, and select the desired 

template, for example this one. A sample of the template will be shown in the preview area. 

Simply click on "Create." A new worksheet will be created based on the template. The worksheet 

will contain cells with preset layout and formatting. You simply need to enter the appropriate 

information in each cell. For example, let’s enter information in these cells.  
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After you make changes to the worksheet, you can save it as a new template so you can use it 

again later. To save the worksheet as a new template, first click on the "Office" button, and then 

select "Save As." The "Save As" dialog box will open. Then, open the "Save as type" list, and 

select "Excel Template" as the file type. The location will change to the "Templates" folder, the 

default location for saving your templates. Before saving the template, enter the desired name for 

it, in the "File name" box. Let's change the template's name, to this one. Then click on "Save." 

The template will be saved. 

 

Now let's close this workbook, and then create a new workbook based on the template we just 

saved. As before, first click on the "Office" button, and then select "New."  The "New 

Workbook" window will open. Click on "My templates." A dialog box will open, displaying the 

templates saved in the "Templates" folder. Here's the template we saved. You can create a new 

workbook based on this template by simply double-clicking on it. 
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B2.31 Time Saving Tips 

In this lesson, I’ll give you a few tips for performing some common tasks more quickly. I’ll show 

you how to: 

 

 Calculate the sum of the numbers in multiple rows or columns 

 and Select the entire worksheet with a single click 

 

Calculating the sum of the numbers in multiple rows or columns 

You can calculate the sum of the numbers in multiple rows or columns at once. For example, 

let's calculate the sum of the numbers in these columns. First select the cells below the numbers 

in each column, and then click on the "Sum" button in the "Editing" group of the "Home" tab. 

The sum of the numbers in each column will be entered below them. 

 

Now, let's calculate the sum of the numbers in these rows. First select the cells to the right of the 

numbers in each row, and then click on the "Sum" button. The sum of the numbers in each row 

will be entered to their right. 

 

Selecting the entire worksheet with a single click 

You can select the entire worksheet at once by simply clicking on the button at the corner of the 

row numbers and column letters. All the worksheet's cells will be selected. 

 

B2.33 RS-Save Formats 

This reading supplement provides information on how to save a workbook's data in formats other 

than the default Excel Workbook format. It includes the following topic: 

 

 Saving data in Tab or Comma delimited format 

 

Saving data in Tab or Comma delimited format 

You can save a workbook's data in Tab delimited or Comma delimited format so it can be 

shared with other programs that process and manage data.  

 

These formats store the worksheets data as plain text, with the data in each row on a separate 

line. 

 

- In the Tab delimited format, the columns are separated by tabs. 

- In the Comma delimited format, the columns are separated by commas. 
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To save a workbook in Tab delimited or Comma delimited format: 

 

1) Open the Office menu, and select Save As. 

2) In the Save As dialog box, open the Save as Type list, and select Text (Tab delimited) or 

CSV (Comma delimited). 

3) Click on the Save button. 

4) A dialog box will appear to let you know that the selected file type does not support 

workbooks that contain multiple worksheets. Click on OK. 

5) Another dialog box will appear indicating that some features in the worksheet may not be 

compatible with the selected format. Click on the Yes button to save the file in this format. 

 

B2.36 Unit 2 End 

You’ve reached the end of Unit 2. Here is a summary of what you learned in this unit. You 

learned how to: 

 

 Use the AutoFill function to copy data or enter a data series 

 Select, move, copy, and delete the data in a group of cells 

 Insert and delete cells, rows and columns 

 Identify and correct errors related to fitting data in a cell 

 Check the spelling of a worksheet's contents 

 Find and replace data in a worksheet 

 Use parentheses to set the order of operations in a formula 

 Use the Count, Max, and Min functions 

 Insert functions in a formula 

 Modify formulas and functions 

 Copy calculations using absolute or relative cell references 

 Identify and correct common formula and function errors 

 Rename, rearrange, insert and delete worksheets 

 Work with Multiple Worksheets 

 Create new worksheets based on templates 

 and Save a worksheet in different formats 
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Unit 3 
 

B3 Unit 3 

 

In this course, you'll learn how to: 

 

 Wrap Text in a Cell 

 Change Data Orientation 

 Add Cell Borders 

 Add Cell Backgrounds 

 Apply Styles 

 Insert Clip Art 

 Add Drawings 

 Insert Page Breaks 

 Add Headers and Footers 

 Hide Rows and Columns 

 Sort Data 

 Filter Data 

 Define a Print Area 

 Set Print Options 

 Create and Modify Charts 

 Interpret Data and Charts 

 and Follow Proper Guidelines for Creating Spreadsheets 

 

B3.1 Wrapping Text in a Cell 

 

You can use the "Wrap Text" option, to display a long text in a single cell, using multiple lines.  

 

Sometimes, when the text in a cell is too long to fit in it, for example this cell, only part of the 

text will be displayed, because the next cell contains data, preventing the text from spilling into 

it. 

 

You can make the whole text appear in the cell by setting the cell’s "Wrap Text" option. First 

select the cell, and then click on the "Wrap Text" button in the "Alignment" group, of the 

"Home" tab. The whole text will appear in the cell in multiple lines. The cell’s height will be 

automatically adjusted to fit all the lines. 
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B3.3 Changing the Orientation of Data 

 

You can change the orientation of data in a worksheet’s cells, to make the data appear at an 

angle. Let’s change the orientation of the data in this cell. First select the cell. Then click on the 

"Orientation" button in the "Alignment" group, of the "Home" tab. A menu will open, displaying 

various data orientation options. Select the desired orientation, for example this one. The data in 

the cell will be oriented as specified. 

 

Now, let’s change the orientation of the data in these cells. Again, first select the cells, and click 

on the "Orientation" button. You can also set the data orientation, by selecting "Format Cell 

Alignment" from the menu. The "Format Cells" dialog box will open, with the "Alignment" 

panel in front. 

 

The area labeled "Orientation" contains elements that let you change the data’s orientation. If you 

click on the box to the left, the data will appear vertically. You can make the data appear at an 

angle, by dragging the red marker in the box on the right. For example, if you drag the marker 

below the center line, the data will tilt down. If you drag the marker above the center line, the 

data will tilt up. The tilt angle is shown in the "Degrees" text box below. You can also enter a 

specific angle in the box. Let’s set the tilt angle to 45 degrees. Once you’ve specified the desired 

orientation, click on OK. The data in the cells will be oriented as specified. 

 

B3.5 Cell Borders 

 

You can make cells stand out in a worksheet, by adding borders to them. Let’s add borders to 

these cells. First select the cells. Then, click on the arrow next to the "Border" button, in the 

"Font" group, of the "Home" tab. A menu containing various borders will be displayed. A sample 

of each border is displayed next to it. Let's select "All Borders" to add a border around each cell. 

Now if you deselect the cells, you’ll see that the cells will appear with the specified border. 

 

Now, let's add borders to these cells. As usual first select the cells, and then click on the down 

arrow next to the "Border" button. Another way you can add borders to the cells, is by first 

selecting "More Borders" from the menu. The "Format Cells" dialog box will open, with the 

"Border" panel in front. 

 

The panel contains an area labeled "Line," which contains different line styles that you can use 

for the border. Simply select the desired line style, for example this one. 
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The "Line" area also contains a "Color" drop down list that lets you select a color for the border 

line. The default selection, "Automatic," normally corresponds to black. You can select the 

desired color, for example this one, by simply clicking on it. 

 

The "Presets" area contains buttons corresponding to predefined borders. The "None" button 

removes any existing cell borders. If you click on the "Outline" button, a border will appear 

around the selected cells, as shown in the preview pane. If you click on the "Inside" button, a 

border will also appear between the cells. 

 

You can modify individual border lines using the buttons around the preview pane. For example, 

you can remove the top border by clicking on the "Top Border" button. You can add the top 

border back in by clicking on the button again. Similarly, you can remove the right border by 

clicking on the "Right Border" button, and you can add the border back in by clicking on the 

button again. 

 

You can also modify the borders by clicking on them in the preview pane. For example, you can 

remove the inside border by simply clicking on it, and you can add the border back in by clicking 

on it again. 

 

Once you’ve specified the desired border, click on OK. Now if you deselect the cells, you’ll see 

that they appear with the border you specified. 

 

B3.7 Cell Shading 

 

You can make a worksheet look more attractive, by adding shading to its cells. Let’s add shading 

to these cells. First select the cells. Then click on the down arrow to the right of the "Fill Color" 

button, in the "Font" group, of the "Home" tab. A gallery of colors will be displayed. Select the 

desired shading color, for example this one.  Now if you deselect the cells, you’ll see that the 

shading you selected has been applied to the cells. 

 

Now, let’s add shading to these cells. Again, first select the cells. Another way you can apply 

shading to the cells, is by first clicking on the "Font" dialog box launcher. The "Format Cells" 

dialog box will open. Click on the "Fill" tab to move its panel to the front. This panel contains a 

variety of shading colors. Select the desired color, for example this one. 

 

The panel also contains a "Pattern Style" drop-down list that lets you apply a pattern to the 

shading. You can simply select a pattern from the list, for example this one. You can also select a 

color for the pattern, from the "Pattern Color" drop-down list. Let’s select this color. 
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Once you’ve specified the desired shading, click on "OK." Now if you deselect the cells, you’ll 

see that the shading you selected has been applied to them. 

 

B3.9 Styles 

 

Style refers to a combination of formats including number format, alignment, font, border, and 

shading. Excel 2007 provides a variety of pre-designed styles that you can quickly apply to any 

cell in the worksheet. 

 

Let’s apply a style to these cells. First select the cells. A partial list of styles is displayed in the 

"Styles" group, of the" Home" tab. You can click on the "More" button on the list’s lower right to 

display the entire list. Each style displays a sample of how a cell will appear in that style, along 

with the style’s name. Simply click on the desired style, for example this one. Now if you 

deselect the cells, you’ll see that the style has been applied to them.  

 

In addition to using the predesigned styles, you can also create your own style, and apply it to the 

cells in your worksheet. To create a new style, first open the "Style" list, and then click on "New 

Cell Style" at the bottom of the list. The "Style" dialog box will open. Enter a name for the style 

in the "Style name" box. 

 

The default formats included in the style are displayed, with a selected check box next to each 

one. You can remove a format that you don’t want to be included in the style, for example this 

one, by simply deselecting its check box. The format will be removed from the style. 

 

You can modify the formats included in the style, by first clicking on the "Format" button. The 

"Format Cells" dialog box will open. You can select the desired style formats in the appropriate 

panels of this dialog box. For example, you can display the "Font" panel, and select the font 

settings you like. Similarly, you can display the "Border" panel, and select the border you like. 

Once you’ve specified the desired formats, click on "OK." The formats will be included in the 

style. You can then save the style, by clicking on the "OK" button in the "Style" dialog box. The 

style will be added to the Style list. 

 

Now, let’s apply the style we created, to these cells. Simply select the cells, and click on the 

style. Now if you deselect the cells, you’ll see that the style has been applied to them. 

 

B3.11 Inserting Clip Art  
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Excel provides a collection of images, referred to as "Clip Art", that you can insert into your 

worksheet to make it look more attractive.  

 

Let’s insert a clip art image in this worksheet. First, select the cell where you want the image to 

appear, for example here. Then, click on the "Insert" tab, and click on the "Clip Art" button in the 

"Illustrations" group. The "Clip Art" task pane will open to let you find and insert the desired 

clip. The "Clip Art" task pane will open to let you find and insert the desired clip. You can find a 

clip by first entering its description in the "Search for" box at the top of the pane. For example, 

let’s look for this clip. 

 

The task pane contains a "Search in" drop-down list that lets you specify the locations to search 

for the clip. The default selection is, "Everywhere," which means all the locations containing 

clips will be searched. Let’s keep the default selection. 

 

The pane also contains a "Results should be" drop-down list that lets you specify the type of clip 

to search for. The list includes various types of media clips, with "Clip Art" selected by default. 

Let's leave the other types deselected and use the default selection. 

 

Once you’ve specified the desired search parameters, click on the "Go" button. Excel will find 

and display a list of clip art images based on your specifications. You can scroll through these 

clips, and insert the one you like, for example this clip, by simply clicking on it. The clip will 

appear in the worksheet. You can then close the "Clip Art" task pane. 

 

The clip will be automatically selected, and will have a border around it to let you resize and 

rotate it as desired. You can drag the side handles in the clip’s border to change its width, drag 

the top and bottom handles to change its height, and drag the corner handles to change its height 

and width at the same time. You can also rotate the clip, by simply dragging the green handle on 

its top border in the desired direction. In addition, you can move the clip anywhere in the 

worksheet, by simply dragging it to the desired location. Once the clip appears the way you want, 

you can deselect it.  

 

B3.14 Adding Drawings 

 

Excel lets you easily draw various lines, shapes, and objects in your worksheet. Let's add some 

drawings to this worksheet. 

 

To add a drawing first click on the "Insert" tab. Then click on the "Shapes" button in the 

"Illustrations" group. A gallery of drawings divided into different categories will be displayed. 
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Let's draw some lines. You can draw a regular line by first clicking on the "Line" button. Then, 

click where you want to start the line, for example here. Now, drag the pointer to draw the 

desired line, and release the mouse button. The line will be placed in the worksheet, and a 

"Format" tab containing various drawing tools will be added to the Ribbon. The line will be 

automatically selected, as indicated by the small circles displayed on its ends. You can deselect 

the line by clicking anywhere outside it. 

 

Now, let’s draw an arrow. Again, click on the "Insert" tab, and click on the "Shapes" button in 

the "Illustrations" group. Then click on the "Arrow" button, and as before, click at the desired 

location and drag to draw the arrow. The arrow will be placed in the worksheet. Again, the 

"Format" tab will appear on the Ribbon. The gallery of drawings will be displayed in the "Insert 

Shapes" group on the left of the tab. 

 

You can also use this gallery to add the desired drawings. For example, you can draw a rectangle 

by first clicking on the "Rectangle" button. Then, click and drag as before to draw the desired 

rectangle. You can use the "Rectangle" button to also draw a square. You would just need to hold 

down the Shift key while dragging. The result will be a perfect square. 

 

Similarly, you can draw an oval by first clicking on the "Oval" button. Then, click and drag to 

draw the desired oval. You can use the "Oval" button to also draw a circle. As before, simply 

hold down the Shift key while dragging. The result will be a perfect circle. 

 

You can display the entire gallery of drawings, by clicking on the "More" button on the gallery’s 

lower right. Now let’s draw an object, for example this one. Again, click and drag to draw the 

object. Then click anywhere outside it to deselect it. 

 



 

 

NOTES: 
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B3.16 Modifying Drawings 

 

You can modify the drawings in a worksheet in various ways. You can move a drawing, for 

example this one, by simply dragging it to the desired location.  

 

You can resize a drawing, for example this one, by first selecting it. Handles for resizing the 

drawing will appear around it. You can drag the side handles to change the drawing's width, drag 

the top or bottom handles to change its height, and drag the corner handles to change its height 

and width at the same time. 

 

You can also rotate the drawing, by simply dragging the green handle on its top border in the 

desired direction. 

 

You can add color to a line, for example this one, by first selecting it. Then click on the "Format" 

tab, and click on the right hand part of the "Shape Outline" button in the "Shape Styles" group. A 

list of colors will be displayed.  Select the desired color, for example this one. The line's color 

will change to the one you selected. 

 

You can also fill a shape, for example this one, with color. Again first select the shape. Then 

click on the right hand part of the "Shape Fill" button in the "Shape Styles" group, and select the 

desired color, for example this one. The shape will be filled with the color you selected. 

 

You can apply a style to a shape, for example this one, by first selecting it. A partial gallery of 

styles is displayed, in the "Shape Styles" group. You can click on the gallery's "More" button to 

view the entire gallery. Then select the style you like, for example this one. The style will be 

applied to the shape. 

 

You can add an effect to a drawing, for example this shape, by first selecting it. Then click on the 

"Shape Effects" button in the "Shape Styles" group. A menu of different effect categories will 

open. If you place the mouse pointer over an effect category, for example this one, the gallery of 

effects available in that category will be displayed. You can then select the desired effect, for 

example this one. The effect will be applied to the shape. 

 

You can replace a drawing, for example this shape, with another one. Again, first select the 

shape. Then click on the "Edit Shape" button, in the "Insert Shapes" group, and move the mouse 

pointer over "Change Shape." The gallery of drawings will be displayed. Select a new shape from 

the gallery, for example this one. The shape will change to the one you selected. 

 



 

 

NOTES: 
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B3.19 Page Breaks 

 

If a worksheet is too large to be printed on one page, Excel will insert automatic horizontal and 

vertical page breaks in the worksheet. The page breaks will divide the worksheet, into multiple 

pages. You can also insert a manual page break at a specific location in the worksheet, to make 

the data, which follows it, start on a new page. 

 

Let’s insert some page breaks in this worksheet. For example, let’s insert a horizontal page break 

here, to make the data below it start on a new page. To insert a horizontal page break, first select 

the row below where you want the page break to be placed. Then open the "Page Layout" tab, 

click on the "Breaks" button in the "Page Setup" group, and select "Insert Page Break" from the 

menu. A page break will be inserted above the selected row. 

 

Now, let’s insert another horizontal page break here. As before, first select the row below where 

you want the page break to be placed. Then click on the "Breaks" button, and select "Insert Page 

Break."  A page break will be inserted at the specified location. 

 

Now let’s insert a vertical page break here, to make the data to its right start on a new page. To 

insert a vertical page break, first select the column to the right of where you want the page break 

to be placed. Then click on the "Breaks" button and select "Insert Page Break." A page break will 

be inserted to the left of the selected column. Now let’s insert another vertical page break, for 

example here. As before, select the column to the right of where you want to the page break to be 

placed, click on the "Breaks" button and select "Insert Page Break." A page break will be inserted 

at the location you specified. 

  

You can view how the page breaks divide the worksheet into different pages, by first clicking on 

the "View" tab. Then click on the "Page Break Preview" button in the "Workbook Views" group. 

The worksheet will appear in reduced size, showing how the page breaks divide the worksheet 

into multiple pages. You can go back to the normal view, by simply clicking on the "Normal" 

button in the "Workbook Views" group. 

 

You can easily remove the page breaks that you inserted in the worksheet. To remove a 

horizontal page break, for example this one, first select the row below it. Then click on the "Page 

Layout" tab. Click on the "Breaks" button in the "Page Setup" group and select "Remove Page 

Break" from the menu. The page break will be removed. To remove a vertical page break, for 

example this one, first select the column to its right. Then click on the "Breaks" button and select 

"Remove Page Break." The page break will be removed. 

 



 

 

NOTES: 
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B3.21 Header and Footer 

 

Excel lets you enter information about your spreadsheet, in two predefined areas at the top and 

bottom of a page. The top area is referred to, as the "Header," and the bottom area is referred to, 

as the "Footer." The header and footer are used to display information such as the spreadsheet’s 

title, date, or page number. The information entered in the header and footer will be printed on 

all the pages of the spreadsheet. 

 

Let’s add a header and footer to this workbook. To display the header and footer areas, you must 

change the view to "Page Layout," by first clicking on the "View" tab. Then click on the "Page 

Layout" button in the "Workbook Views" group. The view will change to "Page Layout," and the 

workbook’s header will be displayed. You can then simply click on the header, and enter the 

desired information in it. For example, let’s enter a title for the workbook. 

 

When you add a header or footer, a "Design" tab containing functions related to headers and 

footers will be added to the Ribbon. You can use the buttons in the "Header and Footer 

Elements" group of this tab to quickly insert information in the header or footer. For example, 

you can insert the current date in the left part of the header, by first clicking there. Then simply 

click on the "Current Date" button. The current date will be entered in the header. 

 

Now, let’s display the footer, by simply clicking on the "Go to Footer" button in the "Navigation" 

group. The footer area will be displayed. 

 

Another easy way you can enter information in the header and footer is using the buttons in the 

"Header & Footer" group. For example, if you click on the "Footer" button, a menu of pre-

defined information that can be entered in the footer will open. You can simply select the desired 

information, for example this one. The information will be entered in the footer.  

 

You can format the header and footer contents like normal text. Let’s scroll up to the header, and 

format the text in the header’s middle section. First click on the section to select its text. Then 

click on the "Home" tab, and use the buttons in the "Font" group to format the text as desired. 

For example, let’s increase the text’s font size, and change its style to "Italic." 

 

You can also easily delete the information in the header or footer. For example, you can remove 

the contents of this header section, by simply clicking on it, and pressing the Delete key. Then 

click outside the header to close it. 

 



 

 

NOTES: 
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You can preview how the header and footer will appear in print, by first clicking on the "Office" 

button. Then move the mouse pointer over "Print," and select "Print Preview." A sample printout 

of the worksheet with its header and footer will be displayed. Then simply click on the "Close 

Print Preview" button.  

 

B3.23 Hiding Rows and Columns 

 

You can make your worksheet less crowded and easier to view by hiding some of its rows and 

columns. 

 

Let’s hide some of the rows in this worksheet, for example these rows. To hide a group of rows, 

first select them by dragging over their row numbers. Then click on the "Format" button, in the 

"Cells" group, of the "Home" tab. A menu will appear, displaying various categories of functions 

for formatting the selected rows. Move the mouse pointer over "Hide & Unhide" under the 

"Visibility" category, and select "Hide Rows" from the submenu. The rows will disappear from 

the worksheet.  

 

Now let’s hide these columns. Again, first select the columns by dragging over their column 

letters. Then click on the "Format" button, move the mouse pointer over "Hide & Unhide," and 

select "Hide Columns." The columns will disappear. 

 

Hiding rows and columns doesn’t actually remove them from the worksheet, or affect any 

formulas and functions referring to their cells. The hidden rows and columns just won’t be 

displayed or printed.  

 

You can tell which rows and columns are hidden, by looking at the row numbers and column 

letters. For example, if you look at the row numbers, you’ll see that they jump from 5 to 9, 

indicating that rows 6 through 8 are hidden. Similarly, if you look at the column letters, you’ll 

see that they jump from C to F, indicating that columns D and E are hidden. 

 

You can easily make the hidden rows and columns reappear in the worksheet. To display the 

hidden rows, first select the rows above and below them. Again, click on the "Format" button, 

move the mouse pointer over "Hide & Unhide," and select "Unhide Rows." The rows will 

reappear.  

 

To display the hidden columns, first select the columns to their left and right. As before, click on 

the "Format" button, move the pointer over "Hide & Unhide," and select "Unhide Columns." The 

columns will reappear. 



 

 

NOTES: 
 

 

 

 

 
Teknimedia Corporation 61 PCIC

3
B2 GS3 

 
 

 
B3.25 Sorting Data 

 

You can sort the data in a worksheet to make it more organized and easier to analyze. 

 

Let’s sort this worksheet’s data. For example, let’s sort the names in this column. First, select 

one of the column’s cells. Then click on the "Sort & Filter" button, in the "Editing" group of the 

"Home" tab. A menu will open to let you specify the sort order. "Sort A to Z", will sort the data 

alphabetically from A to Z, and "Sort Z to A," will sort the data in the reverse order, from Z to A. 

Let's select "Sort A to Z." The names in the column will be sorted from A to Z. The data in the 

adjacent columns will be automatically reordered to keep their relationship with the data in the 

sorted column. 

 

You can easily reverse the sort order, by first clicking on the "Sort & Filter" button again. Then 

simply select "Sort Z to A" from the menu. The names will be sorted from Z to A, and the data in 

the adjacent columns will be reordered accordingly. 

 

You can sort a column of numbers or dates in the same way. For example, you can sort the 

numbers in this column, by first selecting one of its cells. As before, click on the "Sort & Filter" 

button. You can sort numbers from smallest to largest or largest to smallest. Let’s select smallest 

to largest. The numbers will be sorted from smallest to largest. 

 

Now let’s sort the dates in this column. Again, select one of the column’s cells, and click on the 

"Sort & Filter" button. You can sort dates from oldest to newest, or newest to oldest.  Let’s select 

newest to oldest. The dates will be sorted as you specified. 

 

You can also sort the data in multiple columns at the same time. This is useful if the same entry 

in one column corresponds to different entries in another column. You can then sort the data in 

the first column, and sort the corresponding data in the second column, in the desired order as 

well. 

 

Let’s sort the names and test scores at the same time. To sort the data in more than one column, 

first select a cell in one of the columns. Then click on the "Sort & Filter" button, and select 

"Custom Sort" from the menu. The "Sort" dialog box will open. The selected cell and all those in 

its adjacent rows and columns will be highlighted. However, the row containing the column 

headers won’t be selected. By default the "My data has headers" check box is selected, indicating 

the selected cells have a header row which should not be included in the sort. 

 



 

 

NOTES: 
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You can sort the cells, using the lists in the dialog box. First open the "Sort By" list, under 

Column. The list displays the column headers. Select the first column you want to sort. 

 

The list under "Sort On," lets you select the parameter based on which the data will be sorted. By 

default, the data will be sorted based on values. Let's use the default selection. The list under 

"Order" lets you specify the sort order. Let's sort the data from A to Z. 

 

Now let’s specify the sort criteria for the second column. Click on the "Add Level" button. 

Another set of lists will appear to let you sort the second column. Open the "Then by" list, and 

select the desired column. As before, let’s sort the data based on values, and select the desired 

sort order. 

 

Once you have entered the desired sort criteria for the columns you want to sort, click on "OK." 

The data will be sorted as you specified. The names will be sorted, from A to Z, and the scores 

for each name will be sorted from largest to smallest.  

 

B3.27 Filtering Data 

 

Excel has a "Filter" function that allows you to display only the data that meets certain criteria. 

You can filter data based on specific information such as dates, text, and numbers. 

 

To filter data, first click on the "Sort & Filter" button, in the "Editing" group of the "Home" tab. 

Then select "Filter" from the menu. Filter buttons will appear in the column headers. You can 

use these buttons to filter the data, based on the values in each column. 

 

Let's filter the data based on the text in this column. First, click on the column's filter button. The 

filter list will open, displaying the data values in the column. By default, all values are selected, 

indicating they'll be displayed. You can click on the "Select All" checkbox to clear the current 

selections. Then select the values you want to display, for example these two. Now simply click 

on "OK." The data will be filtered, displaying only the rows containing the values you selected. 

The filter results will be displayed in the status bar, and the filter button in the filtered column, 

will contain a picture of a filter, indicating the column has been filtered. 

 

You can easily remove the filter, by first clicking on the "Sort & Filter" button. Then select 

"Clear" from the menu. The filter will be removed and all data rows in the worksheet will be 

displayed. 

 



 

 

NOTES: 
 

 

 

 

 
Teknimedia Corporation 63 PCIC

3
B2 GS3 

 
 

Now let's filter the data based on the dates in this column. Again, first click on the column's filter 

button. The filter list will open, displaying a list of dates. As before, click on the "Select All" 

checkbox to clear the current selections. Then select the desired date, for example this month, 

and click on OK. The data will be filtered, displaying only the rows containing the month you 

selected. 

 

You can also filter the data based on values in multiple columns. For example, let's add another 

filter based on the numbers in this column. Again, click on the column's filter button. The filter 

list will be displayed. Instead of selecting specific numbers, you can filter based on a range of 

numbers, by first placing the mouse pointer over "Number Filters." A submenu will open, 

displaying various number range options. Select the desired option, for example, the "greater 

than" option. The "Custom AutoFilter" dialog box will open, with the top left list containing the 

words "is greater than." Simply type in the desired number in the box to the right of the list, and 

click on "OK."  The data will be filtered, displaying only the rows containing the date and 

numbers you specified. 

 

Once you're done with filtering the data, again click on the "Sort & Filter" button, and click on 

"Filter" to turn it off. The filter will be cleared, and the filter buttons will be removed from the 

columns. 

 

B3.29 Print Area 

 

You can set a "Print Area" so that you can quickly print a specific part of the worksheet. 

 

Let’s set a "Print Area" in this worksheet, to print these cells. First select the cells. Then click on 

the "Page Layout" tab, click on the "Print Area" button in the "Page Setup" group, and select "Set 

Print Area" from the menu. A dashed border will appear around the cells indicating they’ve been 

included in the print area. Now if you use the "Quick Print" function to print the worksheet, only 

the print area will be printed.  

 

You can remove the "Print Area" in order to print the entire worksheet. Again click on the "Print 

Area" button. Then simply select "Clear Print Area" from the menu. The print area will be 

removed. 

 

B3.31 Print Scaling 

 

You can scale your worksheet to make it print on a specific number of pages.  
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To scale a worksheet, first click on the "Page Layout" tab. The "Scale" box in the "Scale to Fit" 

group shows the scale used for printing the worksheet. The default scale is 100%. Let’s use 

"Print Preview" to see how the worksheet will be printed with this scale. The worksheet will be 

displayed as it would appear in print. The current page number and the total number of pages are 

shown on the window’s lower left corner. As you can see, the worksheet will print on 6 pages. 

You can then exit the Print Preview mode, by clicking on the "Close Print Preview" button. 

 

You can make the worksheet print on fewer pages, by entering a smaller value in the "Scale" 

box. For example, let’s change the scale to 80%. Then press the Enter key. Now if you select 

"Print Preview," you can see that the worksheet’s contents appear smaller, and it will print on 4 

pages. Let’s exit the Print Preview mode. 

 

You can also make the worksheet fit on a specific number of pages, by selecting the desired 

number of pages from the "Width" and "Height" lists, in the "Scale to Fit" group. Let's make the 

worksheet’s width fit on 2 pages, and make its height fit on 1 page.  Now if you select "Print 

Preview", you can see that the worksheet will print on 2 pages. Again, let’s exit the Print Preview 

mode. 

 

You can also see how the worksheet will be divided between the pages, by first clicking on the 

"View" tab. Then click on the "Page Break Preview" button, in the "Workbook Views" group. As 

you can see, the worksheet’s width is divided into 2 pages, and its height fits on 1 page. To go 

back to the Normal view, simply click on the "Normal" button, in the "Workbook Views" group. 

 

B3.33 Printing Titles and Gridlines 

 

You can make the contents of a worksheet's printout easier to follow, by printing its title cells, on 

every page. You can also make the printout's contents easier to view by printing the worksheet's 

gridlines. 

 

Let's set up this worksheet to print with repeating titles and gridlines. First, click on the "Page 

Layout" tab. Then click on the "Print Titles" button, in the "Page Setup" group. The "Page Setup" 

dialog box will open, with the "Sheet" panel in front. 

 

You can specify the title rows and columns that you want to repeat on every page using the boxes 

in the "Print titles" area. To specify the desired rows, first click on the button to the right of the 

box labeled "Rows to repeat at top." The dialog box will be reduced to a text box, and the pointer 

will change to a Right arrow. Select the desired row, for example this one, by clicking anywhere 
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on it. Then, click on the button to the right of the text box. The whole dialog box will be 

displayed. The row that you selected will be repeated at the top of every page. 

 

You can specify the desired columns to repeat, by first clicking on the button to the right of the 

box labeled "Columns to repeat at left." Again, the dialog box will be reduced to a text box, and 

the pointer will change to a Down arrow. Select the desired column, for example this one, and 

click on the button to the right of the text box. Again, the whole dialog box will be displayed. 

The column that you selected will be repeated at the left of every page. 

 

You can also print the worksheet's gridlines by simply turning on the "Gridlines" check box 

under the "Print" heading. 

 

Once you've specified the desired print settings, click on "OK." Now, if you print the worksheet, 

the specified title row and column will be printed on every page, and the worksheet's gridlines 

will also be printed.  

 
B3.35 Creating Charts 

 

You can display a worksheet’s data graphically, using a chart. Charts make it easier to compare 

the data and view its trends.  

 

The main element of a chart is the "Data Series." A data series is a group of data in a row or 

column presented by a specific graphic. For example, this data series is presented by these bars, 

and this data series is presented by these bars. 

 

Other standard chart elements include the horizontal axis, which corresponds to the titles of the 

data, and the vertical axis, which corresponds to the data values. In addition, the chart usually 

contains "Legends," which identify each of the data series being displayed. 

 

Excel provides various chart types that present data in different ways. The most common chart 

types include the following: 

 

 the "Column" chart is used for comparing data values.  

 the "Bar" chart is also used for comparing data values. 

 the "Line" chart is used for showing data changes and trends. 

 and the "Pie" chart is used for displaying percentages. 
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Let’s create a chart using this worksheet’s data. First select the cells containing the data you want 

to display in the chart, for example these cells. Then, click on the "Insert" tab. The available chart 

types are displayed in the "Charts" group. Select the desired chart type, for example the 

"Column" chart. A gallery of available forms for the chart type will be shown. Select the desired 

form, for example this one. The specified chart will be inserted in the worksheet. 

 

When you insert a chart, three tabs labeled "Design", "Layout", and "Format" will be added to the 

Ribbon. You can use the functions in these tabs to specify various aspects of the chart. By 

default, the chart’s bars represent the data series in the columns. You can make the bars represent 

the data series in the rows, by simply clicking on the "Switch Row/Column" button, in the "Data" 

group, of the "Design" tab. The bars will represent the data series in the rows. 

  

You can add a title to the chart, by first clicking on the "Layout" tab. Then click on the "Chart 

Title" button, in the "Labels" group. A menu will appear to let you select where you want to 

place the title. Let's place the title above the chart. The "Chart Title" text box will appear above 

the chart. You can simply type the desired title in this box. Then click outside the box to deselect 

it. 

 

You can also add a title to the chart’s horizontal axis, by first clicking on the "Axis Titles" 

button, in the "Labels" group. A menu will open to let you select the desired axis. Move the 

mouse pointer over "Primary Horizontal Axis Title," and select "Title Below Axis" from the 

submenu. A text box labeled "Axis Title" will appear below the horizontal axis. Enter the desired 

title in the box. Then click outside it to deselect it. 

 

B3.37 Modifying Charts-Part 1 

 

In this lesson I'll teach you various ways to modify charts. I'll show you how to: 

 

 move charts 

 resize charts 

 and change chart data 

 

Moving Charts 

You can move a chart within the worksheet by simply dragging it to the desired location. 

 

You can also move the chart to another worksheet, by first clicking on the "Move Chart" button, 

in the "Location" group, of the "Design" tab. The "Move Chart" dialog box will open. The "New 

sheet" option will create a new worksheet, and move the chart there. The "Object in" option lets 
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you display the chart in one of the existing worksheets. By default, the chart is displayed in the 

current worksheet. Let’s use the default option, and click on "OK." Then deselect the chart by 

clicking anywhere outside it. 

 

Resizing Charts 

You can change a chart’s size, by first clicking on a blank part of it to select it. A border 

containing handles for resizing the chart will appear around it. You can drag the side handles to 

change the chart’s width, drag the top or bottom handles to change its height, and drag the corner 

handles to change both its height and width at the same time. 

 

You can also set the chart’s height and width to exact amounts, by first clicking on the "Format" 

tab. Then enter the desired amounts, in the "Height" and "Width" boxes in the "Size" group. For 

example, let’s enter this height. Then press the Enter key. Also, let’s enter this width, and again 

press the Enter key. The chart's height and width will be set to what you specified. You can then 

deselect the chart. 

 

Changing Chart Data 

You can view the data cells included in the chart by simply selecting it. The cells will be marked. 

You can then change the data in any of the cells as desired. For example, let’s change this cell’s 

data, which is presented by this bar. The bar’s height will be automatically adjusted to reflect the 

change. 

 

You can also add new data to the chart. For example, let’s add this data series. Again, first select 

the chart. Then click on the "Select Data" button in the "Data" group, of the "Design" tab. The 

"Select Data Source" dialog box will open. Click on the button to the right of the box, labeled 

"Chart data range." The dialog box will change to a text box.  Then select all the data you want to 

display in the chart, including the data series you want to add, and click on the button to the right 

of the text box. The whole dialog box will be displayed. Click on the "Ok" button. The data 

series will be added to the chart. 

 

B3.39 Modifying Charts-Part 2 

 

In this lesson I'll teach you additional ways to modify charts, including how to: 

 

 modify chart elements 

 change the chart type 

 and change the chart layout and style 
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Modifying Chart Elements 

You can easily modify various elements of a chart, such as the chart’s title, or the bar colors. To 

change the chart’s title, first click on it. A border will appear around the title. You can then edit it 

as desired, and click outside it to deselect it. 

 

Now, let’s change the color of these bars. To change the color of a group of bars, first double 

click on one of them. Then click on the "Format" tab, and click on the right side of the "Shape 

Fill" button, in the "Shape Styles" group. A gallery of colors will be displayed. Simply select the 

desired color, for example this one. The bars will appear in that color. You can then deselect the 

chart. 

 

You can also modify the color of different parts of the chart's background. For example, you can 

change the legend's background, by first clicking there. Then click on the right side of the "Shape 

Fill" button, and select the desired color, for example this one. The legend's background will 

appear in the color you selected. You can then deselect the legend by clicking outside it. Once 

you've modified the chart elements as desired, you can deselect the chart itself. 

. 

Changing the Chart Type 

You can change a chart’s type to present its data in a different way. First select the chart. Then 

click on the "Change Chart Type" button, in the "Type" group, of the "Design" tab. The "Change 

Chart Type" dialog box will open. The list of chart types is displayed on the left of the dialog 

box. Select the desired chart type, for example this one. The available forms for that chart type 

will be displayed on the right. Select the desired form, for example this one. Then click on "OK." 

The data will be presented, using the chart type you selected. 

 

Changing the chart layout and style 

Excel 2007 provides a variety of pre-designed layouts and styles that you can quickly apply to 

your chart. A layout specifies how the charts titles and legends are displayed within the chart, and 

a style specifies the color and appearance of the charts data elements. 

 

Let’s apply a different layout to this chart. A partial gallery of layouts is displayed in the "Chart 

Layouts" group, of the "Design" tab. You can view the entire gallery, by clicking on its "More" 

button, and select the layout you like, for example this one. The chart will appear with the layout 

you selected. 

 

Now, let’s change the chart’s style. A partial gallery of styles is displayed in the "Chart Styles" 

group, of the "Design" tab. Again, click on the gallery’s "More" button to display the entire 
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gallery, and select the desired style, for example this one. The specified style will be applied to 

the chart. You can then deselect it. 

 

B3.41 Interpreting Data and Charts 

 

You can draw many logical and useful conclusions from a worksheet's data. For example, if you 

look at the first quarter sales data in this worksheet, you can see that this salesperson had more 

sales, than the others. Similarly, if you look at the yearly sales, you can see that this salesperson 

had more sales, than the others. 

  

If you look at the data more closely, you may also detect a trend. For example, if you look at this 

salesperson's quarterly sales, you can see that they decreased each quarter. 

 

While you can determine many useful facts and trends from a worksheet's data, you must be 

careful not to jump to conclusions based on the data. For example, just because this salesperson 

had the highest total sales, it does not mean she sold the highest number of products. Other 

factors not represented in the data, such as the price of the products sold may have affected this 

result. Similarly, because the total sales were the lowest in the second quarter, you should not 

conclude that the sales team spent less effort in that period. Other factors such as the economy or 

the weather may have played a role. 

 

You can interpret the worksheet's data more easily by displaying it in a chart. If you look at this 

column chart, you can easily determine how the salespersons performed relative to each other in 

each period. For example, you can see that this salesperson had the highest sales in the second 

quarter, and this one had the highest sales in the third and fourth quarters. 

 

You can also use different chart types to easily view the important information and trends in the 

data. For example, you can use a "Line" chart to display the sales trends. You can then easily see 

that this salesperson's numbers steadily went up each quarter. You can also use a "Pie" chart to 

view the sales percentages, or use a bar chart to compare the sales totals. 

 

Charts can also help you verify that the calculations in the worksheet are correct. For example, if 

you look at this chart carefully, you'll see that the length of the bar representing the total yearly 

sales, is almost the same as those representing the quarterly sales. However, you'd normally 

expect the yearly sales bar to be much longer. This indicates that the total yearly sales calculation 

is probably incorrect. If you click on the calculation's cell, you'll notice that it contains the 

"Average" function, instead of the "Sum" function. You can then correct the calculation by 

simply changing "Average" to "Sum." The chart will be automatically updated to reflect the 
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change. Now, the yearly sales bar is much longer than the quarterly sales bars, as you'd expect it 

to be. 

 

B3.42 RS-Guidelines for Creating Spreadsheets 

 

This reading supplement describes common uses and types of spreadsheets. It also provides 

guidelines for creating well-organized, easy-to-view spreadsheets. It includes the following 

topics: 

 

• Uses and Types of Spreadsheets 

• And Guidelines for Creating Spreadsheets 

 

Uses and Types of Spreadsheets 

 

Spreadsheets are used for many useful purposes. They are used to manage data, make 

calculations, create charts and graphs, and analyze data and trends. 

 

 Some of the most common types of spreadsheets include: 

 Budgets used for managing income and expenditures. 

 Time sheets used for tracking employee work hours. 

 Class records used for keeping student scores and averages. 

 Company financial reports used for tracking revenues and profit, and identifying trends. 

 

Guidelines for Creating Spreadsheets 

 

In order to create well-organized, attractive and easy-to-view spreadsheets, you should use the 

following guidelines: 

 

 Label the data rows and columns with proper headings.  

 Organize the data rows and columns logically. 

 Add borders and shading to highlight important information. 

 Format similar text and data elements consistently. 

 Use charts to clearly illustrate data and trends. 

 Add descriptive text to identify chart elements. 

 Separate groups of data by topic into labeled worksheets. 

 Make sure your spreadsheet does not contain any errors. 
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B3.44 Unit 3 End 

 

You’ve reached the end of Unit 3. Here is a summary of what you learned in this unit. You 

learned how to: 

 

 Wrap text in a cell 

 Change the orientation of data in a cell 

 Apply borders and shading to cells 

 Create styles and apply them to cells 

 Insert clip art pictures in a worksheet 

 Move and resize pictures in a worksheet 

 Add drawings to a worksheet 

 Move and resize drawings in a worksheet 

 Insert page breaks in a worksheet 

 View a worksheet in the Page Break Preview mode 

 Add a header and footer to a worksheet 

 Hide and unhide rows and columns 

 Sort data based on a single or multiple criteria 

 Filter data based on different criteria 

 Define a print area within a worksheet 

 Scale a worksheet to print on a specific number of pages 

 Print gridlines and repeating rows and columns 

 Create charts based on a worksheet's data 

 Modify a chart's type and elements 

 Draw conclusions from a worksheet's data and charts 

 and Follow proper guidelines for creating spreadsheets 

 

  


